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Einführung

Willkommen zu MX-View, der grafischen Benutzeroberfläche für die Tas
Harddisk-Recorder der Serien MX und MM.

Dieses Handbuch soll sowohl dem Anfänger als auch dem erfahrenen To
nieur als Leitfaden für die Arbeit mit MX-View dienen. Wer sich bereits 
alten Hasen im Umgang mit Audioanwendungen zählt, möchte wahrsche
möglichst schnell zum Ziel kommen, ohne das gesamte Handbuch zu lese
Sie zu dieser Gruppe gehören, so raten wir Ihnen, zumindest Kapitel 3 un
durchzulesen. Sie finden darin einen Überblick über alle Fenster und Scha
von MX-View sowie einige grundlegende Hinweise zum Aufnehmen, Ed
Anpassen und zum Umgang mit virtuellen Spuren. Sie werden überrascht
viele neue Funktionen, Tastenkombinationen und neue Arbeitsmethoden 
decken werden.

All jene, die bisher noch keine Audiodaten am Computer editiert haben, h
herzlich willkommen. Bevor Sie mit der Arbeit beginnen, sollten Sie sich
nehmen, dieses Handbuch durchzublättern und sich mit den verschiedene
stern und Schaltflächen vertraut zu machen. Nehmen Sie Ihre Maus, und 
zeigen Ihnen alles, was Sie über MX-View wissen müssen: Von der Aufna
Wiedergabe bis zum Editieren und Sichern Ihrer Projekte. Halten Sie sich
für eine ganz neue Erfahrung in Sachen Audiobearbeitung.

Beachten Sie bitte, dass dieses Benutzerhandbuch sich eingehend mit der
zeroberfläche MX-View auseinandersetzt und als Ergänzung zu den MX-
und MMR/MMP-Handbüchern gedacht ist. Sie finden darin keine Erkläru
Synchronisation, zu digitalen Anschlussmöglichkeiten oder zur Bedienun
die Frontplatte.
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Einführung

Konventionen und Symbole
Folgende Konventionen und Symbole werden in diesem Handbuch durch
verwendet:

> Das Pfeilsymbol verdeutlicht eine Menüstruktur. View > Waveforms b
Sie öffnen zunächst das Menü View und darin dann den Eintrag Wavefo

Befehlstaste Befehlstaste bedeutet, dass Sie auf einem Macintosh-Computer die Befeh
(auch Apfel-Taste genannt) drücken.

Strg Strg bedeutet, dass Sie auf einem Microsoft-Windows-Computer die Strg
(auch als Ctrl-Taste bezeichnet) drücken.

+ Mit dem Pluszeichen kennzeichnen wir das Drücken und Halten einer Sc
griffstaste. Beispiel: Strg + B bedeutet, dass Sie die Strg-Taste gedrückt h
dann die B-Taste drücken.

Hinweis So sind wichtige, aber nicht immer offensichtliche Hinweise gekennzeich

TIPP Hier finden Sie Tipps, die Ihnen verraten, wie Sie die Funktionen Ihres Re
optimal ausnutzen.

Hinweis Einige Screenshots in diesem Handbuch entsprechen möglicherweise nic
grafischen Bedienoberfläche auf Ihrem Bildschirm. Die ist auf die Verwe
unterschiedlicher Betriebsysteme (Windows, MacOS, BeOS) zurückzufüh
kann sich aber auch um Änderungen durch Softwareupdates handeln.
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Was ist neu in dieser Version (v1.30)?
Mit v1.30 ist MX-View nun in der ersten offiziellen Version erhältlich. Z
wird ein Update der MX-Firmware auf v3.05 verfügbar.

Wichtig! Um in den Genuss der Verbesserungen an der Wellenformdatenbank un
Dateisystem zu kommen, müssen Sie Ihre Festplatten neu formatieren, b
sie unter der MX-OS-Version 3.05 verwenden können. Sichern Sie Ihre Pr
formatieren Sie Ihre Laufwerke und spielen Sie anschließend Ihre Projekt
zurück.

Die wichtigsten Neuerungen:
• Zugriff auf Locatormarken: das Übersichtsfenster für Locatormarken is

verfügbar. Dort lassen sich Locatormarken anzeigen, ansteuern, umbene
löschen (siehe Abschnitte 3.4, Markers-Fenster und 9.1, Locatormar

wenden).
• Benutzergruppen: Spuren lassen sich einer von 12 Gruppen zuordnen u

gemeinsam bedienen und editieren – auch über mehrere Recorder hinw
leichten optischen Unterscheidung kann man für die Gruppen unterschi
Farben auswählen, in denen auch die Wellenformen dargestellt werden 
Abschnitte 3.5, Groups-Fenster und 9.2, Mit Benutzergruppen arbei
AM MX-View Benutzerhandbuch v1.30DE  8
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Ethernet-Verbindung einrichten

In diesem Kapitel stellen wir die beiden grundlegenden Ethernet-Hardwa
gurationen vor. Anweisungen zum Installieren der MX-View-Anwendun
Sie in einer gesonderten Datei. Welche Softwareeinstellungen auf Ihrem 
und auf dem (den) MX-2424 erforderlich sind, um die Kommunikation z
lichen, ist im Anhang A:, MX-View und MX-2424 über ein Netzwerk v

binden, beschrieben.

Systemanforderungen
Die Systemanforderungen sind in den Release-Notes zu MX-View besch

MX-2424/MMR direkt an den Computer anschließen
Mithilfe eines Crossover-Ethernet-Kabels der Kategorie 5 können Sie ein
puter, auf dem MX-View installiert ist, direkt mit einem MX-2424/MMR
binden. Stecken Sie ein Ende des Kabels in die Ethernet-Schnittstelle am 
und das andere Ende in die Ethernet-Schnittstelle des Computers.

MX-2424/MMR über einen Ethernet-Hub an einen Computer ansch
Über einen 100BaseT-Fast-Ethernet-Hub können Sie einen oder eine Gru
MX-2424/MMR-Recordern an einen MX-View-Computer anschließen. B
in dieser Konfiguration verwendeten Kabeln muss es sich um genormte E
Patch-Kabel der Kategorie 5 handeln.

Crossover-Ethernet-Kabel

Computer
AM MX-View Benutzerhandbuch v1.30DE  9
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Ethernet-Verbindung einrichten

Verbinden Sie alle Recorder sowie den Computer mit dem Hub, wie in de
dung unten gezeigt. Die Uplink-Schnittstelle des Hubs dürfen Sie nur ver
wenn Sie den Hub mit einem anderen Hub verbinden.

Hinweis Die Kabellänge bei Ethernet-Verbindungen sollte 100 Meter nicht über

TIPP Es sind durchaus auch komplexere Netzwerkkonfigurationen mit einer R
MX-View-Workstations, Routern, Hubs und Recordern realisierbar. Wend
sich zum Einrichten eines komplexen Netzwerks an einen Netzwerkadm

Ethernet-Patch-Kabel

Ethernet-Patch-Kabel

Ethernet-Patch-Kabel

Ethernet-Patch-Kabel

Ethernet Hub
AM MX-View Benutzerhandbuch v1.30DE  10
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Überblick

In diesem Kapitel stellen wir die wichtigsten Fenster von MX-View einsc
kurzer Beschreibungen vor, damit Sie sich mit den Funktionen von MX-V
traut machen können.

Das MX-View-Hauptfenster

Input All: Versetzt alle aktiven 
Spuren in den Input-Modus

Record Arm All: Versetzt alle aktiven Spuren  
in Aufnahmebereitschaft. Edit All: Versetzt alle  

Spuren in den Editier- 
Modus.

In-Punkt

Out-Punkt

Locatormarke Zeitleiste

markiertes Audiomaterial

Spurnummer

aktive Spur

Inaktive  
virtuelle Spur

Aufnahmebereitschaft:
Rot blinkend - Aufnahmebereit
Konstant rot leuchtend - Aufnahme läuft

Eingang:
Konstant gelb leuchtend - Eingang bereit
Halb erleuchtet - Aufnahmebereit

Wiedergabeposition

Virtuelle Spuren 
anzeigen/verbergen

Spurname

Gruppe

Eventname

Anfasser für 
virtuelle Spur

Taste für Spurmenü

Spureditiertaste
AM MX-View Benutzerhandbuch v1.30DE  11
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Um den auf dem Bildschirm verfügbaren Platz zu vergrößern, können Sie
Spalten des MX-View-Hauptfensters einzeln ein- oder ausblenden. Um b
Spalten anzuzeigen bzw. zu verbergen, wählen Sie im Menü View > Col
und markieren die Spalten, die angezeigt werden sollen.
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Laufwerkssteuerung

Bandzählwerk: Zeigt die  
Wiedergabeposition an.  
Sie können hier die gewünschte  
Position auch direkt eingeben

In- und Out- 
Punkte setzen

Bereichswerkzeug:  
Dient vor allem zum  
Auswählen und Bearbeiten  
von Audiobereichen

Auswahlwerkzeug: Dient zum Auswählen 
und Bearbeiten einzelner Events, zum  
Ziehen und Anpassen von Events sowie  
zur Pegel- und Mute-Automation

Scrub-Werkzeug
Bleistift

Feld für Nudge-Wert

Lupe: Dient zum Vergrößern oder  
Verkleinern (Zoomen) einer Audioregion

Feld für Pre-Roll-We

Feld für Post-Roll-W

Aktivieren/Deaktivieren der  
Pre-Roll- und Post-Roll-Funktion

Feld für  
In-Punkt-Wert

Feld für  
Out-Punkt-Wert

Feld für  
Auswahllänge

Rücklauf

Rückwärtswiedergabe

Stopp

Wiedergabe

Vorlauf

Aufnahme

Rehearse  
(Probe-Modus)

Online

rojektanfang springen

rückwärts springen

vorwärts springen

zum Ende springen

automatische  
Aufnahme/Probe 

Loop (Endlos- 
wiedergabe/-aufnahme)
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Project/Track-Fenster

Festplatte: ID der SCSI-Festplatte,  
dahinter in Klammern  
der verbleibende Speicherplatz

Projektname: Doppelklicken Sie,  
um ein Projekt zu öffnen

Spurname
Projekte 

anzeigen/verbergen

Spuren 
anzeigen/verbergen

Symbol: Beachten Sie, dass das Symbol  
das verwendete Dateisystem anzeigt  
(in diesem Fall das Apple-Logo)
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Markers-Fenster

Zeitpositionen der 
Locatormarken

Namen der 
Locatormarken

Locatormarken- 
symbole und -nummern
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Groups-Fenster

Namen der Gruppen
Nummern und Farben 

der Gruppen

Doppelklicken, um alle 
Gruppen zu deaktivieren
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Edit-Leiste
Die Edit-Leiste bietet Ihnen Zugriff auf häufig verwendete Funktionen, d
sechs Kategorien unterteilt sind (von links nach rechts): 

• Optionen für die Spuranzeige, 
• grundlegende Editierfunktionen, 
• Auswahl der Zwischenablage, 
• Auswahl des Editiermodus, 
• erweiterte Editierfunktionen, 
• Fenster öffnen.
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Machine Info-Leiste
Die Machine Info-Leiste zeigt wichtige technische Informationen an, dar
Projektnamen, die Samplingfrequenz, die Art des Timecodes, den Steuer
modus, den Buszustand, die Sample-Referenz, die Kodierung der Audiod
Aufnahmemodus sowie ID und Typ der verwendeten Festplatte. Die Busy
entspricht der BUSY-LED auf der Frontplatte des Geräts und ist vor allem
hilfreich, wenn der Recorder in einem Geräteraum steht oder sich außer S
befindet. 

Mithilfe des Pulldown-Menüs können Sie im numerischen Feld auf der re
Seite wahlweise den Bus-Versatz, den Timecode-Versatz, den aktuellen T
oder den verbleibenden Speicherplatz anzeigen.

Die Machine Info-Leiste können Sie so anpassen, dass sie nur die von Ih
tigten Informationen anzeigt. Wählen Sie Menü View > Machine Info
Segments, und markieren Sie die Segmente, die angezeigt werden solle
AM MX-View Benutzerhandbuch v1.30DE  18
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Network-Fenster
Das Network-Fenster listet die Geräte auf, zu denen Sie eine Verbindung h
können. Es ist vor allem dann hilfreich, wenn Sie mehrere Recorder an ei
chronisierten Bus betreiben. Um mehrere Recorder in einem einzigen MX
Fenster anzuzeigen, markieren Sie die gewünschten Geräte und doppelkl
darauf.

Das Network-Fenster können Sie so anpassen, dass es nur die von Ihnen 
tigten Spalten anzeigt. Klicken Sie im Network-Fenster auf das Menü Ma
Columns, und markieren Sie die Spalten, die angezeigt werden sollen.

GeräteinformationenGerätename:  
Doppelklicken Sie,  
um das MX-View-Hauptfenster  
anzuzeigen
AM MX-View Benutzerhandbuch v1.30DE  19
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Schnelleinstieg

In diesem Kapitel führen wir Sie Schritt für Schritt durch Ihr erstes Proje

Ein neues Projekt beginnen
Um ein neues Projekt zu beginnen, stellen Sie zuerst eine Verbindung zum
gewünschten Recorder her:

1 Rufen Sie das Network-Fenster auf, indem Sie in der Edit-Leiste a
Network-Symbol klicken.

2 Doppelklicken Sie auf den Namen des gewünschten Recorders.

Das Hauptfenster von MX-View wird angezeigt. 

3 Wählen Sie im Menü File den Eintrag New Project. 

Das folgende Fenster wird angezeigt:

4 Geben Sie einen Namen für das Projekt ein, und wählen Sie dann
SCSI-ID der Aufnahmefestplatte, die Bittiefe, die Samplingfreque
die Art des Timecodes. 

5 Wenn Sie bei Ihrer Session im Bandmodus arbeiten möchten, akt
Sie das Kontrollkästchen Tape mode. 

6 Klicken Sie auf OK, um fortzufahren. 

Die Aufnahme kann beginnen!
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Grundlegende Aufnahme- und Wiedergabefunktionen

Aufnahme

1 Wählen Sie mithilfe der Aufnahmebereitschaftstasten die Spuren
die Sie aufnehmen möchten.

2 Klicken Sie auf die Aufnahmetaste in der Laufwerkssteuerung, di
zu blinken beginnt.

3 Um mit der Aufnahme zu beginnen, klicken Sie auf die Wiederga

Die blinkende Aufnahmetaste und die Tasten für die Aufnahmebereitschaft leu
stetig – die Aufnahme läuft.

Um die Aufnahme anzuhalten, drücken Sie die Leertaste, oder verwende
Stopptaste in der Laufwerkssteuerung. Deaktivieren Sie anschließend die
nahmebereitschaft geschalteten Spuren.

Das aufgenommene Audiomaterial wird nun in Form von „Audioevents“
ereignissen) in den einzelnen Spuren dargestellt. Diese Events können Si
auf vielfältige Weise editieren.

Wiedergabe

1 Um die Wiedergabemarke zum Anfang des Projekts zu bewegen,
Sie auf Head in der Laufwerkssteuerung.

2 Klicken Sie auf die Wiedergabetaste ( ) oder drücken Sie die L
auf Ihrer Tastatur, um Ihre Aufnahme abzuspielen.

TIPP Wenn das Bereichswerkzeug ( ) aktiv ist, können Sie die Wiedergabem
innerhalb des MX-View-Hauptfensters durch einfaches Klicken mit der M
jede beliebige Stelle bewegen.

Eine ausführliche Beschreibung der Wiedergabe-, Aufnahme- und Laufw
tionen finden Sie in Kapitel 6, Wiedergabe, Navigation und Aufnahme

ahmebereitschaft

euchten während der  
ufnahme stetig

zum Anfang springen
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Audiomaterial kopieren und einfügen
In MX-View können Sie Audiomaterial auf einfache Weise kopieren und
anderer Stelle wieder einfügen.

Einen Bereich auswählen

1 Aktivieren Sie das Bereichswerkzeug ( ) in der Laufwerkssteue

2 Ziehen Sie nun mit dem Mauszeiger über dem gewünschten Bere
Audiodaten eine Markierung auf.

Kopieren

3 Um den markierten Bereich in die Zwischenablage zu kopieren, k
Sie auf die Kopieren-Schaltfläche in der Edit-Leiste.

Einfügen
Zum Einfügen müssen Sie zunächst die Stelle bestimmen, an der die Dat
fügt werden sollen. 

zu bearbeitender Bereich  
ist markiert

eren     Einfügen
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4 Markieren Sie durch Ziehen mit dem Bereichswerkzeug die gewü
Stelle.

5 Klicken Sie auf die Einfügen-Schaltfläche, um den Inhalt der Zwi
ablage am gewünschten Punkt einzufügen.

Einen solchen Vorgang können Sie jederzeit rückgängig machen oder wie
indem Sie auf die entsprechende Schaltfläche in der Edit-Leiste klicken.

Eine ausführliche Beschreibung der Editierfunktionen finden Sie in Kapi
erweiterten Editierfunktionen sind in Kapitel 8 beschrieben.

Audiomaterial soll  
hier eingefügt werden

aus Zwischenablage  
eingefügtes Audioevent

ängig    Wiederherstellen
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Audioevents anpassen

1 Um ein Audioevent anzupassen, wählen Sie das Event zunächst m
Auswahlwerkzeug ( ) in der Laufwerkssteuerung aus. 

Die Anfasser des Events, mit denen Sie die Lautstärke, Länge oder den Fade-W
sen können, werden angezeigt.

2 Um die Länge eines Events anzupassen, ziehen Sie den linken hori
Anfasser nach links oder nach rechts.

Eine ausführliche Beschreibung der verschiedenen Funktionen zum Anpa
Audioevents finden Sie in Kapitel 8.

horizontale Anfasser

ausgewähltes Event

Pegel-Anfasser

Fade-Anfasser
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Grundsätzliches zu virtuellen Spuren
MX-View arbeitet mit drei verschiedenen Arten von Spuren: geladenen S
virtuellen Spuren und entladenen Spuren. In diesem Abschnitt befassen w
mit geladenen und virtuellen Spuren.

• Geladene Spuren sind „aktive“ Spuren, die Sie wiedergeben, editieren u
die Sie aufnehmen können. Diese Spuren werden im MX-View-Hauptf
angezeigt.

• Virtuelle Spuren sind „inaktive“ Spuren. Sie sind sichtbar und können e
werden, stehen allerdings nicht für Aufnahme oder Wiedergabe zur Ver

Eine neue virtuelle Spur erstellen

1 Um eine neue virtuelle Spur zu erstellen, wählen Sie die Spur aus
Sie eine alternative Aufnahme erstellen möchten. 

2 Wählen Sie wie unten gezeigt im Spurmenü Track > New Virtua

3 Geben Sie einen neuen Namen für die virtuelle Spur ein, und klic
auf OK.

Die neue virtuelle Spur erscheint nun unterhalb der ursprünglichen Spur.

Schaltfläche für das Spurmenü

Spurmenü
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Eine virtuelle Spur laden
Um eine virtuelle Spur für die Aufnahme und Wiedergabe nutzen zu kön
müssen Sie sie laden, das heißt „aktivieren“:

1 Klicken Sie auf die Aktivierungsschaltfläche der Spur.

Die Schaltfläche leuchtet auf und zeigt an, dass die Spur geladen bzw. aktivier

Eine ausführliche Beschreibung der Arbeit mit virtuellen Spuren finden S
Abschnitt 5.5, Mit Spuren arbeiten und in Kapitel 11, Spuren.

Die virtuelle Spur 1 ist inaktiv.  
Sie können das Audiomaterial dieser Spur  

betrachten und bearbeiten, aber nicht  
wiedergeben. Eine Aufnahme ist ebenfalls  

nicht möglich.

Spur 3 ist inaktiv wie Spur 1.

Durch Klicken auf die Schaltfläche  
wurde die virtuelle Spur 2 aktiv.  

Sie können nun Audiomaterial  
aufnehmen und wiedergeben.
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Grundlagen und verwendete Begriffe

Dieses Kapitel enthält einen allgemeinen Überblick über Projekte, Spuren
Wellenformen und die Arbeit mit Fenstern. Die beiden letzten Abschnitte
Kapitels befassen sich mit dem Setzen von In- und Out-Punkten und der 
numerischer Werte.

Mit Fenstern arbeiten
Die Fenster von MX-View ermöglichen es Ihnen, die Arbeitsumgebung a
persönlichen Bedürfnisse anzupassen. Sie können die Fenster von MX-V
anzeigen oder verbergen, sie verschieben, minimieren oder wiederherstel
MX-View-Fenster öffnen Sie, indem Sie die entsprechende Schaltfläche 
rechten Bereich der Edit-Leiste anklicken. Sie können das gewünschte Fe
auch über das Pulldown-Menü Windows oder mittels einer Tastenkomb
aufrufen.

Hinweis Die verschiedenen MX-View-Fenster haben teils unterschiedliche Eigen
Auf Fenster mit besonderen Funktionen werden wir gesondert hinweis
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Macintosh
Auf einem Macintosh können Sie ein MX-View-Fenster ganz einfach auf d

schirm verschieben, indem Sie den Rand des Fensters anklicken und es zieh

Größe des Fensters ändern Sie, indem Sie auf die rechte untere Ecke klicke

ziehen. 

Die Merkmale eines Fensters unter Macintosh OS 9:

Option Tastaturbefehl Win Tastaturbefehl M

Fenster schließen Strg + W Befehlstaste + W

Schließen

Fenstergröße ändern  
(zum Ändern der Größe ziehen)

Reduzieren/Verbergen

Vergrößern/Wiederherstellen

nach oben/unten  
scrollen

nach links/rechts scrollen
AM MX-View Benutzerhandbuch v1.30DE  28
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Microsoft Windows
Auf einem Microsoft-Windows-Computer können Sie ein MX-View-Fen
einfach auf dem Bildschirm verschieben, indem Sie die Titelleiste des Fe
anklicken und es ziehen. Sie können die Größe des MX-View-Fensters eb
ändern, indem Sie die Seiten oder den unteren Rand des Fensters anklick
ziehen oder auf die untere rechte Ecke des Fensters klicken.

Ein Fenster unter Microsoft Windows 98 weist folgende Merkmale auf:

Über das Pulldown-Menü Windows im MX-View-Hauptfenster können S
ster aufrufen. Sie können die Fenster auch mithilfe der folgenden Tastenk
tionen öffnen bzw. schließen:

Option Tastaturbefehl Win Tastaturbefehl M

Laufwerkssteuerung Strg + 1 Befehlstaste + 1

Geräteeinstellungen Strg + 2 Befehlstaste + 2

Übersicht Strg + 3 Befehlstaste + 3

Pegelanzeigen Strg + 4 Befehlstaste + 4

Marker Strg + 5 Befehlstaste + 5

Projekt/Spur Strg + 7 Befehlstaste + 7

nach links/rechts scrollen

Fenstergröße ändern  
(zum Ändern der Größe ziehen)

Maximieren/Wiederherstellen

Schließen

nach oben/unten  
scrollen

Minimieren
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Fenster andocken
Die Laufwerkssteuerung und das Overview-Fenster sowie die Machine In
Edit-Leiste sind andockbar, das heißt, sie können am MX-View-Hauptfen
ankert werden. Sie lassen sich aber auch frei positionieren oder ganz ausb

Nach dem Starten von MX-View ist die Laufwerkssteuerung normalerwe
sichtbar und frei verschiebbar über dem MX-View-Hauptfenster angeord
Machine Info-Leiste und die Edit-Leiste sind oberhalb der Zeitleiste an d
View-Hauptfenster angedockt.

Ein andockbares Fenster oder eine Leiste verbergen oder anze
Die frei positionierte Laufwerkssteuerung und das Overview-Fenster kön
wie jedes andere Fenster unter Windows oder MacOS einfach schließen. 
Fenster wieder anzuzeigen, klicken Sie entweder auf die entsprechende S
fläche auf der Edit-Leiste, oder wählen Sie im Menü Windows > Transp
Windows > Overview. 

Die Edit- und Machine Info-Leiste können Sie anzeigen oder verbergen, i
im Menü View > Edit bar bzw. View > Machine Info bar wählen. In

Machine Info-Leiste
in verankertem Zust

MX-View-Hauptfens

Edit-Leiste in 
 verankertem Zustand
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ankertem Zustand können Sie die Edit- und Machine Info-Leiste auch ve
indem Sie sie schließen wie unter 5.1, Mit Fenstern arbeiten beschriebe

Ein unverankertes Bildschirmelement andocken
Jedes andockbare Bildschirmelement (Fenster oder Leiste) wird an einer 
bestimmten Stelle des MX-View-Hauptfensters angedockt. Um ein unver
Fenster anzudocken, klicken Sie darauf und ziehen es in Richtung seiner 
position. Das Bildschirmelement rastet automatisch ein.

Ein verankertes Bildschirmelement lösen
Um ein verankertes Bildschirmelement (Fenster oder Leiste) aus seiner V
rung zu lösen, klicken Sie darauf und ziehen es von seiner Andockpositio
Das Bildschirmelement wird vom MX-View-Hauptfenster gelöst und ist 
positionierbar.

Edit- und Informations- 
leiste sind verborgen 
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Fenster erweitern
Die Größe der Laufwerkssteuerung, der Machine Info-Leiste und der Edi
können Sie verändern, um so den Umfang der angezeigten Informationen
Bedürfnisse anzupassen. Um die Größe eines dieser Bildschirmelemente 
dern, darf es nicht verankert sein. Klicken Sie auf die unten gezeigten Pfe
um das Fenster oder die Leiste zu erweitern bzw. zu reduzieren.

TIPP Jedes Mal, wenn Sie MX-View beenden, werden die Fensterpositionen g
chert. Beim nächsten Start von MX-View werden die Fenster wieder entsp
ihrer Position beim Beenden angeordnet.

Verkleinern

Erweitern
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Mit Projekten arbeiten

Ein neues Projekt erstellen
Ein neues Projekt erstellen Sie, indem Sie im Menü File > New Project
Das Fenster New Project wird angezeigt.

Geben Sie den gewünschten Projektnamen (maximal 28 Zeichen), die ID
nahmefestplatte, die Samplingfrequenz und Bittiefe, die Art des Timecod
den gewünschten Aufnahmemodus (Bandmodus oder nicht überschreiben
Modus) ein.

Verwenden Sie die Listenfelder,  
um die gewünschten Einstellungen  
vorzunehmen

Option Tastaturbefehl Win Tastaturbefehl

Neues Projekt Strg + N Befehlstaste + N
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Projekte öffnen
Um ein vorhandenes Projekt zu öffnen, wählen Sie im Menü File > Proj
Track. Das Fenster Project/Track wird geöffnet.

Beachten Sie, dass das Fenster Project/Track mehrere Geräte und Festpla
halten kann. Klicken Sie auf den gewünschten Recorder und die Festplat
um alle darauf gespeicherten Projekte anzuzeigen. Um ein vorhandenes P
öffnen, doppelklicken Sie auf das Symbol des gewünschten Projekts.

Projekte schließen
Wenn Sie ein neues oder anderes Projekt öffnen, wird das aktuell geladen
automatisch geschlossen.

Wenn Sie ein Projekt schließen und den Recorder ausschalten möchten, m
Sie zuerst alle Festplatten deaktivieren (Unmount). Den Befehl finden S

Festplatte

Spur

Projekt

Option Tastaturbefehl Win Tastaturbefehl M

Projekt öffnen Strg + O Befehlstaste + O
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Menü Volumes des Project/Track-Fensters sowie auf der Frontplatte des
ders. Nach dem Deaktivieren können Sie das Gerät ausschalten.

Hinweis Projekte werden automatisch auf Festplatte gespeichert, sobald Sie Stop
und die Busy- und Laufwerks-LEDs nicht mehr leuchten.

Alle Laufwerke entladen
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Mit Spuren arbeiten
Wie bereits erwähnt, gibt es in MX-View drei verschiedene Arten von Sp
Geladene Spuren, virtuelle Spuren und entladene Spuren.

Geladene Spur (aktive Spur)
Eine geladene Spur in MX-View verhält sich wie eine Spur auf einem Me
corder. Sie können alle geladenen Spuren gleichzeitig wiedergeben und v
dene Instrumente auf verschiedene Spuren aufnehmen. 

Geladene Spuren erscheinen im MX-View-Hauptfenster und stehen für d
nahme und Wiedergabe zur Verfügung. Sie können in jeder Spur zahlreic
Audioevents bearbeiten und organisieren.

Die Anzahl der Spuren, die Sie in MX-View laden können, wird nur durc
Recorder selbst begrenzt. Mit dem MX-2424 stehen für Aufnahme/Wied
also maximal 24 Spuren zur Verfügung, während der MMR-8 maximal 8
verarbeiten kann.

Virtuelle Spur (Inaktive Spur)
Virtuelle Spuren erscheinen zwar im MX-View-Hauptfenster, sie stehen a
für die Aufnahme oder Wiedergabe zur Verfügung. Sie sind vor allem da
lich, wenn Sie viele Takes zu einer Spur zusammenfassen möchten oder u
schiedliche Takes vergleichen möchten. Der MX-2424 kann bis zu 100 v
(entladene) Spuren verarbeiten. Virtuelle Spuren sind eigentlich „inaktive
Sie können sie jedoch aktivieren, indem Sie auf die Aktivierungsschaltflä
AM MX-View Benutzerhandbuch v1.30DE  36
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entsprechenden Spur klicken und so die zuvor geladene bzw. aktive Spur
vieren.

Entladene Spur
Entladene Spuren werden im MX-View-Hauptfenster nicht angezeigt. Sie
in Listenform im Project/Track-Fenster zur Verfügung. Wenn Sie entladen
wiedergeben möchten, müssen Sie sie zuerst in das MX-View-Hauptfens
Pro Projekt sind auf dem MX-2424 bis zu 999 entladene Spuren möglich

Einzelheiten zur Verwaltung von Spuren finden Sie in Kapitel 11, Spuren

Inaktive virtuelle Spur

Aktive/geladene Spur

V1 ist inaktiv. 
Aufnahme und Wiedergabe  

sind nicht möglich. 
Sie können die Spur  

jedoch bearbeiten.

V2 ist aktiv. 
Aufnahme und Wiedergabe 

 sind möglich.
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Events, Bereiche und Wellenformen
Ein Event ist ein Audioclip, den Sie innerhalb von geladenen und virtuelle
editieren und verschieben können.

Audioevents können als Wellenformen angezeigt werden, die eine grafisc
stellung der Audiodaten sind. Sie können die Anzeige von Wellenformen
schalten, indem Sie die Option View > Waveforms markieren. Wellenf
werden während der Aufnahme oder beim erstmaligen Laden des Projekt

Ein Bereich ist ein Audiosegment, das Sie zu Editierzwecken wählen kön
Bereich kann ein Event sein, ein Teil eines Events oder eine Gruppe von 

Numerische Felder
Numerische Felder dienen in MX-View dazu, unter anderem Locatorpun
und Out-Punkte, Nudge-Einstellungen sowie Pre- und Post-Roll-Werte an
und zu verändern. Es gibt zwei Methoden, einen numerischen Wert einzu

Wellenform (dunkelgrau)

Event
AM MX-View Benutzerhandbuch v1.30DE  38



5

TASC

d, um es 

e des 

 1).

das Feld 

 Esc-Taste.

t zu 
l ein. 

enzende 
nden 

das Feld 

 Esc-Taste.
Grundlagen und verwendete Begriffe

Das gesamte numerische Feld markieren

1 Klicken und ziehen Sie mit dem Mauszeiger über das gesamte Fel
zu markieren.

2 Geben Sie die gewünschten Ziffern ein, die wie auf der Frontplatt
MX-2424 von rechts nach links erscheinen. 

Im Beispiel links wurde die Ziffernfolge 12345612 eingegeben (beginnend mit

3 Drücken Sie die Eingabetaste, um die Eingabe zu bestätigen und 
zu verlassen.

Um das Feld zu verlassen, ohne den aktuellen Wert zu ändern, drücken Sie die

Einzelne Ziffernpaare markieren

1 Klicken Sie einmal auf ein Ziffernpaar, um es zu markieren.

2 Drücken Sie die Nach-oben- bzw. Nach-unten-Taste, um den Wer
erhöhen bzw. zu vermindern, oder geben Sie eine zweistellige Zah

Im Beispiel links wurde die Nach-oben-Taste viermal gedrückt:

3 Drücken Sie die Nach-links- bzw. Nach-rechts-Taste, um das angr
Ziffernpaar zu markieren (also zwischen Stunden, Minuten, Seku
und Frames zu wechseln). 

Im Beispiel links wurde die Nach-rechts-Taste zweimal gedrückt.

4 Drücken Sie die Eingabetaste, um den Eintrag zu bestätigen und 
zu verlassen.

Um das Feld zu verlassen, ohne den aktuellen Wert zu ändern, drücken Sie die
AM MX-View Benutzerhandbuch v1.30DE  39
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In- und Out-Punkte setzen
Für die meisten Editierfunktionen in MX-View müssen Sie In- und Out-P
setzen. Dazu gibt es mehrere Möglichkeiten.

Punkte erfassen
Wenn Sie auf die Schaltfläche Capture In klicken, wird an der aktuellen
gabeposition der In-Punkt gesetzt.

Wenn Sie auf die Schaltfläche Capture Out klicken, wird entsprechend
aktuellen Wiedergabeposition der Out-Punkt gesetzt.

Werte direkt eingeben
Klicken Sie wie im vorherigen Abschnitt beschrieben auf den gewünscht
des In- bzw. Out-Punkt-Feldes, und geben Sie den neuen Wert ein.

Einen Bereich oder ein Event markieren
Klicken und ziehen Sie mit dem Bereichswerkzeug, um den gewünschten
zu markieren. Am Anfang und Ende des markierten Bereichs erscheinen 

In-Punkt Out-Punkt

Out-Punkt erfassen

Numerisches Feld für Out-Punkt

Numerisches Feld für In-Punkt

In-Punkt erfassen
AM MX-View Benutzerhandbuch v1.30DE  40
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In- bzw. Out-Punkte. Alternativ können Sie auch mit dem Auswahlwerkz
einmal auf ein Event (oder eine Gruppe von Events) klicken. Die Anfang
Endzeiten der Events werden nun als In- bzw. Out-Punkte übernommen. 

Einzelheiten zum Auswahl- und Auswahlwerkzeug erfahren Sie in Absch
Einen Bereich zum Editieren auswählen.

Schnellzugriffstasten verwenden

Ziehen mit der Maus
Durch Ziehen mit der Maus können Sie die In- und Out-Punkte auch auf 
leiste verschieben. 

Option Tastaturbefehl Win Tastaturbefehl M

In-Punkt setzen Strg + � Befehlstaste + �

Out-Punkt setzen Strg + � Befehlstaste + �

Ziehen 
des In-Punkts
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In diesem Kapitel befassen wir uns mit den verschiedenen Aufnahme- un
gabemodi, den einzelnen Optionen und den nötigen Bedienschritten. In e
führlichen Abschnitt über die Navigation finden Sie Informationen zu de
Locatorfunktionen, zum Zoomen und Hinweise, wie Sie sich in einem Pr
bewegen.

Wiedergabeoptionen

Wiedergabe
Sie starten die Wiedergabe, indem Sie auf die Wiedergabetaste ( ) in de
werkssteuerung klicken oder die Leertaste auf Ihrer Tastatur drücken. So
keine andere Wiedergabeoption gewählt haben, bleibt die Wiedergabema
rend der Wiedergabe in der Bildschirmmitte stehen, und die Audiospuren
sich von rechts nach links.

Seitenweise Anzeige mit laufender Wiedergabemarke
Wenn Sie diese Option wählen (Menü Playback > Pages With Playhe
die Wiedergabemarke während der Wiedergabe nach rechts über den Bild
Sobald sie den rechten Rand des Bildschirms erreicht, wird der Fensterin
Seite weitergeblättert, und die Wiedergabemarke beginnt erneut vom link
sterrand nach rechts zu laufen.

„In to Out“-Wiedergabe
Bei der „In to Out“-Wiedergabe setzt die Wiedergabe am In-Punkt ein. S
Out-Punkt erreicht ist, kehrt die Wiedergabemarke zum In-Punkt zurück 
an. Dies ist eine bequeme Methode zum Abhören von Audiomaterial. Um
dergabe im „In to Out“-Modus zu starten, setzen Sie die In- und Out-Punk

Option Tastaturbefehl Win Tastaturbefehl M

Wiedergabe und Stopp Leertaste Leertaste
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Abschnitt 5.8, In- und Out-Punkte setzen), und wählen Sie dann im Me
Playback > In to Out.

Beispiel:

TIPP Wenn bei der „In to Out“-Wiedergabe die Pre- und Post-roll-Zeiten berüc
werden sollen, markieren Sie in der Laufwerkssteuerung die Kontrollkäs
Pre- bzw. Post-roll. Die „In to Out“-Wiedergabe setzt dann zur Pre-roll-Z
dem In-Punkt ein und endet zur Post-roll-Zeit nach dem Out-Punkt. Einz
zu Pre-roll- und Post-roll-Einstellungen finden Sie weiter unten im Absch
dergabe mit Pre-/Post-Roll (Pre/Post Roll On Play).

Loop-Wiedergabe
Für die Loop-Wiedergabe müssen Sie zuerst die In- und Out-Punkte wie 
Abschnitt 5.8, In- und Out-Punkte setzen beschrieben definieren.

Option Tastaturbefehl Win Tastaturbefehl M

„In to Out“-Wiedergabe � + Wiedergabetaste � + Wiedergabetas

1 Die Wiedergabeposition springt zum  
In-Punkt und beginnt die Wiedergabe.

2 Sobald der Out-Punkt erreicht ist,  
kehrt die Wiedergabeposition  
zum In-Punkt zurück und hält an.

Out-PunktIn-Punkt

21

Pre-roll und Post-roll 
aktivieren/deaktivieren
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Klicken Sie auf die Schaltfläche Loop in der Laufwerkssteuerung, um di
Wiedergabe zu starten.

Hinweis Es gibt drei Loop-Modi: Wiederholte Wiedergabe (der Standardmodus, P
Repeatedly), Einmal wiedergeben und zurück (Play Once and Cue) sowie
wiedergeben und anhalten (Play Once and Stop). Den gewünschten Mo
len Sie im MX-2424-Menü 210 aus.

Um die Loop-Wiedergabe anzuhalten, drücken Sie eine beliebige Laufwe

Loop-Schaltfläche:  
leuchtet in aktiviertem Zustand hellgelb

Option Tastaturbefehl Win Tastaturbefehl M

Loop-Wiedergabe Strg + L Befehlstaste + L

In-PunktPre-roll

Post-rollOut-Punkt

2

1

Die In- und Out-Punkte sind definiert, 
der Loop-Modus wird aktiviert.
1 Die Wiedergabeposition springt 
zum Pre-roll-Punkt vor dem In-Punkt 
und beginnt mit der Wiedergabe.
2 Die Wiedergabeposition spielt bis 
zur Post-roll-Zeit nach dem Out-
Punkt und stoppt dann.
3 Abhängig von dem im MX-2424-
Menü 210 ausgewählten Loop-
Modus wird a) die Schleife  
so lange wiederholt, bis Sie sie 
anhalten, b) die Wiedergabe-position 
zu Punkt 1 zurückgesetzt und 
angehalten oder c) die Wieder-
gabeposition an Punkt 2 angehalten.
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Wiedergabe wiederholen (Last Play)
Diese Option lässt die Wiedergabe erneut an dem Punkt beginnen, an dem
zuletzt gestartet wurde. Wählen Sie dazu im Menü Playback > Last.

Abhör-Wiedergabemodi
Mehrere Abhör-Wiedergabemodi vereinfachen die Wiedergabe ausgewäh
Audioevents und Bereiche. Sie greifen auf diese Modi entweder über das
Playback oder mithilfe von Tastenkombinationen zu.

Option Tastaturbefehl Win Tastaturbefehl M

Wiedergabe wiederholen L L

Option Tastaturbefehl Win Tastaturbefehl M

To In T, dann I T, dann I

To Out T, dann O T, dann O

From In F, dann I F, dann I

From Out F, dann O F, dann O

Thru In Y, dann I Y, dann I

Thru Out Y, dann O Y, dann O

Abhör-Wiedergabemodi 
 im Menü Playback
AM MX-View Benutzerhandbuch v1.30DE  45



6

TASC

de läuft. 
 bei 

kts 
s in der 
laufleiste 
emarke 

 Ansicht 
arke im 
 wieder, 
k > 
rke zen-

head)
yhead 
riert. Sie 
marke 

 Sie 
z normal 
 Return 
ster zur 

ac
Wiedergabe, Navigation und Aufnahme

Wiedergabemarke folgt Ansicht (Locate With View)
Die Funktionsweise dieser Option hängt davon ab, ob das Laufwerk gera
Wenn Sie im Menü Playback > Locate With View aktiviert haben und
angehaltenem Laufwerk die Ansicht zu einem anderen Bereich des Proje
bewegen, so folgt die Wiedergabemarke der Ansicht und erscheint jeweil
Mitte des Bildschirms. Wenn Sie beispielsweise mithilfe der unteren Bild
einen Refrain weiter hinten in Ihrem Stück anzeigen, folgt die Wiedergab
der Ansicht.

Wenn Sie bei laufendem Laufwerk (Wiedergabe oder Aufnahme) mit der
zu einem anderen Bereich des Projekts wechseln, läuft die Wiedergabem
Hintergrund unsichtbar weiter. Sie sehen die Wiedergabemarke erst dann
wenn Sie manuell zu ihrer Position zurückkehren oder im Menü Playbac
Return View to Playhead wählen (siehe Ansicht auf Wiedergabema

trieren (Return View To Playhead)).

Ansicht auf Wiedergabemarke zentrieren (Return View To Play
Bei dieser Funktion, die Sie im Menü Playback > Return View To Pla
finden, wird die Bildschirmansicht wieder auf die Wiedergabemarke zent
ist vor allem dann nützlich, wenn das Laufwerk läuft und die Wiedergabe
nicht zu sehen ist.

Angenommen, es wird gerade der Anfang des Stücks wiedergegeben und
bewegen die Ansicht zum Ende des Stücks, dann wird die Wiedergabe gan
fortgesetzt, während Sie das Ende des Projekts betrachten. Wenn Sie dann
View to Playhead wählen, springt die Ansicht im MX-View-Hauptfen
Position der Wiedergabemarke zurück.

Option Tastaturbefehl Win Tastaturbefehl M

Ansicht auf Wiedergabemarke 
zentrieren

Strg + P Befehlstaste + P
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Wiedergabe mit Pre-/Post-Roll (Pre/Post Roll On Play)
Normalerweise müssen Sie die Wiedergabemarke erst ein wenig zurück b
wenn Sie einen kurzen Abschnitt des Audiomaterials vor der aktuellen Po
hören möchten. Umgekehrt ist es oft wünschenswert, wenn die Wiederga
kurz nach dem Out-Punkt gestoppt wird, etwa, um eine Auswahl besser üb
zu können.

Dies ist möglich, indem Sie im Menü Playback > Pre/Post Roll On Pl
vieren und sich vergewissern, dass Sie vor dem Start der Wiedergabe auc
Kontrollkästchen Pre-Roll in der Laufwerkssteuerung markiert haben. 

Die Pre-Roll-Zeit wird bei normaler Wiedergabe und bei der „In to Out“-
gabe berücksichtigt. Die Post-Roll-Zeit wird nur berücksichtigt, wenn Sie
Abschnitt mittels der „In to Out“-Funktion wiedergeben und in der Laufw
steuerung die Option „Post Roll“ markiert ist.

Hinweis Diese Funktion hat nichts mit den auf der Frontplatte des MX-2424 eing
Pre-/Post-Roll-Menüs 212 und 213 zu tun. Die Pre-/Post-Roll-Zeiten der M
und 213 sind nur im Zusammenhang mit den Loop- oder Abhör-Wiederg
von Bedeutung. Die Pre-Roll- und Post-Roll-Zeiten in der Laufwerkssteue
beeinflussen nicht die Funktion der Laufwerkstasten auf der Frontplatte
2424, sondern wirken sich auf die Wiedergabe oder „In to Out“-Wiederg

Zurück nach Wiedergabe (Return After Play)
Wenn Sie diese Option im Menü Playback > Return After Play wähl
die Wiedergabemarke nach dem Anhalten des Laufwerks zu ihrer Startpo
zurück.

Option Tastaturbefehl Win Tastaturbefehl M

Wiedergabe mit Pre-/Post-Roll Strg + K Befehlstaste + K
AM MX-View Benutzerhandbuch v1.30DE  47
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Rückwärtswiedergabe (Reverse Play)
Die Rückwärtswiedergabe kehrt die Laufrichtung des Laufwerks um, das 
Wiedergabemarke läuft mit normaler Wiedergabegeschwindigkeit auf de
schirm von rechts nach links. 

Klicken Sie auf die Schaltfläche für die Rückwärtswiedergabe ( ) in de
werkssteuerung, um die Rückwärtswiedergabe zu starten.
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So bewegen Sie sich in Ihrem Projekt
Mit MX-View ist es ein Leichtes, in einem Projekt die gewünschte Stelle
suchen. Dazu stehen Ihnen die im Folgenden beschriebenen Werkzeuge z
Verfügung.

Bandzählwerk verwenden
Das Bandzählwerk in der oberen linken Ecke der Laufwerkssteuerung er
Ihnen, die gewünschte Bandposition einzugeben und direkt anzusteuern. 
Sie einfach wie in Abschnitt 5.7, Numerische Felder beschrieben die Ba
tion ein, und drücken Sie die Eingabetaste.

Schneller Vor- und Rücklauf
Der schnelle Vorlauf und Rücklauf funktionieren genauso wie auf jedem 
Bandgerät, einschließlich verlangsamtem Anlauf und Auslauf (Ramp-up 
Ramp-down). Den schnellen Vor- bzw. Rücklauf aktivieren Sie mithilfe d
sprechenden Schaltflächen in der Laufwerkssteuerung oder mithilfe von 
kombinationen.

Option Tastaturbefehl Win Tastaturbefehl M

Schneller Vorlauf Strg + . (Punkt) Befehlstaste + . (Pu

Schneller Rücklauf Strg + , (Komma) Befehlstaste + , (Ko

Schneller Rücklauf Schneller Vorlauf
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Wiedergabemarke zu nächster/vorheriger Locatormarke bewe
Mithilfe dieser Funktion können Sie die Wiedergabemarke schnell zur nä
oder vorherigen Locatormarke bewegen. Sie ist nur über Tastenkombinati
fügbar:

TIPP Um einen Bereich zwischen Locatormarken auszuwählen, halten Sie die 
taste- und Strg-Taste gedrückt, und springen Sie mit den Pfeiltasten zum 
oder vorherigen Locatorpunkt.

Weitere Informationen zu Locatormarken finden Sie in den Abschnitten 3
Markers-Fenster und 9.1, Locatormarken verwenden.

Wiedergabemarke zum nächsten/vorherigen Edit bewegen
Drücken Sie die Tabulatortaste bzw. Umschalt- + Tabulatortaste, um mit 
dergabemarke schnell zum nächsten bzw. vorherigen Edit zu springen. D
Funktion steht auch über die Schaltflächen NEXT und PREV in der Laufw
steuerung zur Verfügung.

Zum Anfang/Ende gehen
Um zum Anfang des Projekts zu gehen, klicken Sie auf die Schaltfläche 
der Laufwerkssteuerung ( ). Dadurch wird die Wiedergabemarke unm
zum Beginn des ersten Audioevents bewegt. Um zum Ende des Projekts z
klicken Sie auf die Schaltfläche TAIL in der Laufwerkssteuerung ( ). D
wird die Wiedergabemarke unmittelbar zum Ende des letzen Audioevent

Option Tastaturbefehl Win Tastaturbefehl M

Nächste Locatormarke Strg + � Befehlstaste + �

Vorherige Locatormarke Strg + � Befehlstaste + �

Option Tastaturbefehl Win Tastaturbefehl M

Nächster / vorheriger Edit Tab / � + Tab Tab / � + Tab

Vorheriger Nächster
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In- und Out-Punkte aufsuchen
Drücken Sie die Taste „I“, um die Wiedergabemarke zum In-Punkt zu be
Drücken Sie die Taste „O“, um die Wiedergabemarke zum Out-Punkt zu 

Schrittweise zurück/vorwärts gehen (Roll Back / Roll Forward)
Wenn Sie die Kommataste (,) drücken, „rollt“ bzw. springt die Wiedergab
um den im MX-2424-Menü 260 eingestellten Wert zurück (Vorgabewert 
5 Sekunden). Sie können die Kommataste auch mehrere Male drücken, u
zurückzugehen. Wenn Sie beispielsweise bei der Standardeinstellung von
5 Sekunden die Kommataste dreimal drücken, springt die Wiedergabema
15 Sekunden zurück. Um vorwärts zu springen, verwenden Sie die Punkt-
Diese Funktionen stehen Ihnen auch über das Menü Playback > Roll Ba
Playback > Roll Forward zur Verfügung.

TIPP Diese Funktion entspricht dem zweimaligen Antippen der Rücklauf- bzw
tasten auf der Frontplatte des MX-2424 oder RC-2424.

Klicken im MX-View-Hauptfenster
Klicken Sie mit dem Bereichswerkzeug ( ) einmal in eine Spur des MX
Hauptfensters, um die Wiedergabemarke zu dieser Position zu bewegen.

Option Tastaturbefehl Win Tastaturbefehl M

In-Punkt aufsuchen I I

Out-Punkt aufsuchen O O

Option Tastaturbefehl Win Tastaturbefehl M

Schrittweise zurück/vorwärts , (Komma) / . (Punkt) , (Komma) / . (Punk
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Werkzeuge zur Navigation

Horizontales Vergrößern/Verkleinern (Zoomen)
Durch horizontales Zoomen können Sie Wellenformen detailliert bis hina
Einzelsample-Ebene anzeigen. Sie haben zwei Möglichkeiten, im MX-V
Hauptfenster Material ein- oder auszuzoomen: Die Zoom-Schaltflächen i
Edit-Leiste und die Lupe in der Laufwerkssteuerung.

• Die Zoom-Schaltflächen in der Edit-Leiste bewirken ein Zoomen in Ein
ten. Wenn Sie auf diese Schaltflächen klicken, verbleibt die Wiedergabe
der Bildschirmmitte.

• Mit der Lupe in der Laufwerkssteuerung ( ) können Sie den Bereich
len, den Sie detaillierter darstellen möchten. Klicken und ziehen Sie zu
Zweck den Bereich auf, den Sie vergrößern möchten. Beachten Sie, das
durch die Wiedergabemarke nicht versetzt wird, es sei denn, Sie haben 
Playback > Locate with View aktiviert. Mit der Lupe können Sie eb
Einzelschritten ein- oder auszoomen. Klicken Sie auf den Bereich, den 
größern möchten. Um auszuzoomen, halten Sie beim Klicken die Umsc
gedrückt.

Gesamtes Projekt anzeigen
Um das gesamte Projekt von Anfang bis Ende anzuzeigen, wählen Sie im
View > View Whole Project.

TIPP Um das gesamte Projekt anzuzeigen, können Sie auch auf die Schaltfläch
Lupe in der Laufwerkssteuerung doppelklicken.

Option Tastaturbefehl Win Tastaturbefehl M

Gesamtes Projekt anzeigen Strg + � + Z Befehlstaste + � + 

zoomen Auszoomen
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Samples anzeigen
Sie können die Ansicht bis auf Einzelsample-Ebene heranzoomen, indem
fach die Z-Taste gedrückt halten. Auf diese Weise können Sie einen Edit 
einen Trennpunkt schnell überprüfen. Wenn Sie die Z-Taste loslassen, ke
Anzeige zur ursprünglichen Zoomstufe zurück. Diese Funktion steht Ihne
über das Menü View > View Samples zur Verfügung. Allerdings wird
nicht die ursprüngliche Ansicht wiederhergestellt.

Höhe der Spuren ändern
Sie können die Höhe der einzelnen Spuren in 10 Stufen ändern. Um die S
zu vergrößern oder zu verkleinern, klicken Sie auf die entsprechende Sch
im linken oberen Bereich der Edit-Leiste.

Vertikales Zoomen
Durch vertikales Zoomen vergrößern Sie die Amplitude der Wellenform,
exakteres Editieren ermöglicht. Klicken Sie dazu auf die Schaltflächen fü
kales Ein- bzw. Auszoomen im mittleren Bereich der Edit-Leiste.

Mit der Maus scrollen
Sie können zum Scrollen auch die Maus verwenden, indem Sie in das MX
Hauptfenster klicken und die Ansicht nach links oder rechts ziehen.

Option Tastaturbefehl Win Tastaturbefehl M

Samples anzeigen Z Z

Option Tastaturbefehl Win Tastaturbefehl M

Spurhöhe vergrößern Strg + + (Plus-Zeichen) Befehlstaste + +
(Plus-Zeichen)

Spurhöhe verkleinern Strg + – (Minus-Zeichen) Befehlstaste + – 
(Minus-Zeichen)

rhöhe vergrößern

Spurhöhe verkleinern

ertikal einzoomen

Vertikal auszoomen
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Im MX-View-Hauptfenster nach oben/unten scrollen
Mithilfe der Bild-auf- bzw. Bild-ab-Taste können Sie nach oben oder unt
die Spuren blättern. Wenn Sie beispielsweise gerade Spuren 9 bis 16 betr
erreichen Sie durch Drücken der Bild-auf-Taste, dass die Spuren 1 bis 8 a
werden.

Um an den Anfang der Spurliste zu gelangen, drücken Sie die Pos1-Taste
das Ende der Spurliste zu gelangen, damit Spur 24 sichtbar wird, drücken
Ende-Taste.

Hinweis Auf manchen Laptops und besonders kompakten Tastaturen sind die Bil
Bild-ab-Tasten bzw. Pos1-/Ende-Tasten eventuell nicht vorhanden.
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Optionen für die Aufnahme
MX-View lässt sich bei der Aufnahme im Grunde so einfach wie ein herk
cher Bandrecorder bedienen. Im Folgenden sind die einzelnen Optionen f
Aufnahme beschrieben.

Einfache Aufnahmen
Um eine Spur für die Aufnahme auszuwählen, klicken Sie auf die Aufnah
reitschaftstaste neben der gewünschten Spur, die daraufhin zu blinken be

Um mit der Aufnahme zu beginnen, klicken Sie auf die Aufnahmetaste in
Laufwerkssteuerung, die daraufhin ebenfalls zu blinken beginnt. Klicken
auf die Wiedergabetaste. Die blinkende Aufnahmetaste und die Tasten fü
nahmebereitschaft leuchten nun stetig – die Aufnahme läuft.

TIPP Verwenden Sie die Schaltfläche „Alle auf Aufnahmebereitschaft“ ( ) ü
normalen Aufnahmebereitschaftstasten, um alle Spuren in Aufnahmebe
zu versetzen. Sie können damit auch die Aufnahmebereitschaft aller Spu
tivieren.

Um die Aufnahme zu beenden, drücken Sie einfach die Leertaste, oder ve
Sie die Stopptaste in der Laufwerkssteuerung. Um die Aufnahme zu beend
die Wiedergabe anzuhalten, klicken Sie auf die Wiedergabetaste in der L

Aufnahmebereitschaft

leuchten während der  
Aufnahme stetig
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steuerung. Einzelne auf Aufnahme geschaltete Spuren können Sie auch d
vieren, indem Sie einmal auf die Aufnahmebereitschaftstaste der jeweilig
klicken.

TIPP Wenn Ihnen eine Aufnahme nicht gefällt, klicken Sie einfach auf die Sch
„Rückgängig“ ( ) in der Edit-Leiste. Weitere Informationen zu den Fun
Rückgängig und Wiederherstellen erfahren Sie in Abschnitt 7.25, Rückgä
machen und Wiederherstellen (Undo, Redo).

Auto-Aufnahme (Punch-in/out) und Probemodus (Auto-Rehear
Bei der Auto-Aufnahme schaltet das Laufwerk am In-Punkt auf Aufnahm
setzt bei Erreichen des Out-Punkts die normale Wiedergabe fort. Für eine
Aufnahme müssen Sie zuerst die In- und Out-Punkte definieren. Versetze
gewünschten Spuren in Aufnahmebereitschaft, klicken Sie auf die AUTO
fläche und anschließend auf die Aufnahmetaste in der Laufwerkssteue
Nun sollten die Tasten für Aufnahmebereitschaft und Aufnahme rot blink
rend die AUTO-Schaltfläche stetig rot leuchtet: .

Bewegen Sie die Wiedergabemarke zu einer beliebigen Stelle vor dem In
und drücken Sie auf Aufnahme. Der Recorder startet die Wiedergabe u
beginnt am In-Punkt mit der Aufnahme. Sobald der Out-Punkt erreicht ist
Aufnahme beendet und die Wiedergabe fortgesetzt. Um das Laufwerk an
klicken Sie auf die Stoptaste.

Der Probemodus (Auto-Rehearse) funktioniert genauso, nur nimmt der R
hierbei nicht auf. Stattdessen schaltet er auf das Eingangssignal um, um p
können, wie es später auf der Aufnahme klingt. Klicken Sie für Auto-Reh
AUTO und dann auf REH. Die REH-Taste blinkt nun gelb, während die A

Option Tastaturbefehl Win Tastaturbefehl M

Aufnahme Strg + Leertaste Befehlstaste + Leer

Stop Leertaste Leertaste
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Taste stetig gelb leuchtet. Klicken Sie auf die Wiedergabetaste, um die A
Rehearse-Wiedergabe zu starten.

Um den Probe- oder Auto-Aufnahme-Modus zu verlassen, klicken Sie ei
die AUTO-Taste.

Hinweis Für bequeme Auto-Punch-Aufnahmen können Sie die Auto-Aufnahme m
und Post-Roll-Zeiten kombinieren.

Loop-Aufnahme
MX-View kennt mehrere Loop-Modi:

• Wiederholte Wiedergabe (Voreinstellung): In diesem Modus wird ohne 
chung fortlaufend über das vorhandene Audiomaterial aufgenommen.

• Einmal wiedergeben und anhalten: In diesem Modus erfolgt eine Aufna
Nach Erreichen des Out-Punkts und der Post-Roll-Zeit hält das Band an

• Einmal wiedergeben und zurück: In diesem Modus erfolgt eine Aufnah
Danach kehrt die Wiedergabemarke zum Pre-Roll-Punkt vor dem In-Pu
zurück.

Bevor Sie eine Loop-Aufnahme durchführen, müssen Sie im MX-2424-M
zunächst den Loop-Modus bestimmen. Setzen Sie dann die In- und Out-P
versetzen Sie die Spuren in Aufnahmebereitschaft, und klicken Sie auf di
Taste in der Laufwerkssteuerung. Die AUTO-Taste sollte nun stetig rot le
Klicken Sie auf die Aufnahmetaste in der Laufwerkssteuerung, die da
ebenso wie die Tasten der aufnahmebereiten Spuren zu blinken beginnt. K

leuchtet stetig gelb

blinkt gelb

Option Tastaturbefehl Win Tastaturbefehl M

Auto-Aufnahme-/
Auto-Rehearse-Modus

Strg + � + A Befehlstaste + � + 
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Sie auf die Schaltfläche LOOP in der Laufwerkssteuerung, um die Loop-
nahme zu starten. Die Laufwerkssteuerung sieht dann wie folgt aus:

Die Rehearse-Loop-Funktion funktioniert genauso, nur klicken Sie hierb
REH-Taste und nicht auf die Aufnahmetaste.

Loop-Aufnahme mit Auto-Entladen
Die Option „Auto Unload“ bewirkt, dass eine Spur nach der Aufnahme a
tisch entladen wird. Sie können so gleich eine neue Aufnahme durchführ
die vorhergehende zu überschreiben. Die Auto-Entladen-Funktion schalt
MX-2424-Menü 211 ein oder aus. Diese Option ist vor allem dann hilfrei
Sie aus mehreren Takes die beste Aufnahme heraussuchen wollen.

Externe Synchronisation
Zwar werden die meisten Einstellungen für die externe Synchronisation d
2424 und der Recorder der MM-Serie im Machine Settings-Fenster vorge
aber die wichtigsten Parameter finden Sie auch in der Machine Info-Leis
der Laufwerkssteuerung. Wenn das Laufwerk mit einem externen Gerät s
siert ist, muss die Schaltfläche ONLINE gedrückt sein. Sie befindet sich i
linken unteren Ecke der Laufwerkssteuerung und leuchtet in gedrücktem
stetig gelb: .

TIPP Wenn Sie beim Klicken auf die ONLINE-Schaltfläche die Strg-Taste gedr
ten, werden alle gültigen Geräte aktiviert.

Die Machine Info-Leiste enthält eine Übersicht über die wichtigsten Gerä
lungen. Daneben können Sie mit der Machine Info-Leiste auch eingehend

Option Tastaturbefehl Win Tastaturbefehl M

Loop-Funktion Strg + L Befehlstaste + L
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code kontrollieren, den Bus- und Timecodeversatz einstellen und den noc
Aufnahmen verfügbaren Festplattenspeicherplatz überprüfen. Um diese E
lungen anzuzeigen oder zu ändern, öffnen Sie das Menü rechts neben der
LED.

Den Timecode- und Bus-Versatz stellen Sie wie in Abschnitt 5.7, Numer

Felder beschrieben im Feld rechts neben dem Dropdown-Menü ein. Die 
platz- und Timecode-Anzeige können Sie nicht ändern.

Dropdown-Menü Numerisches Feld

Klicken, um den 
gewünschten Wert 

 auszuwählen
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Anzeigeoptionen

Alle Wellenformen vorab laden (Preload All Waveforms)
Die Option Preload All Waveforms im Menü View verbessert die Da
lungsgeschwindigkeit von Wellenformen. Sie empfiehlt sich vor allem be
reichen und komplexen Sessions mit hoher Editierdichte.

Subframes
Durch die Option Subframes im Menü View wird den numerischen Fe
MX-View ein zweistelliger Subframe-Wert hinzugefügt.

Trennpunkte (Splice Points)
Durch die Option Splice Points im Menü View werden die Anfangs- u
punkte jedes Audioevents mit Linien gekennzeichnet. Trennpunkte bewir

Subframes
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deutlichere Trennung einzelner Events. So können Sie eng beieinander st
Events besser auseinander halten.

Trennpunkte deaktiviert

Trennpunkte aktiviert
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Dieses Kapitel enthält eine ausführliche Beschreibung grundlegender Ed
tionen wie Bereichsauswahl, Ausschneiden, Kopieren, Einfügen und Info
tionen darüber, wie Sie die Mehrfachzwischenablage nutzen.

Einen Bereich zum Editieren auswählen
Bevor Sie Ihr Audiomaterial editieren können, müssen Sie einen Bereich
kieren. Dazu gibt es mehrere Möglichkeiten: Mithilfe des Bereichswerkz
hilfe von Spureditiertasten und In- und Out-Punkten oder aber mithilfe de
Auswahlwerkzeugs.

Bereichswerkzeug
Im Gegensatz zum Auswahlwerkzeug, mit dem Sie einen Bereich marki
aus einem oder mehreren Events besteht, dient das Bereichswerkzeug (
Auswählen bzw. Markieren von beliebigen Audiobereichen.

• Ziehen Sie mit dem Bereichswerkzeug eine Markierung um den gewün
Bereich auf. Dabei werden automatisch In- und Out-Punkte gesetzt und
reditiertasten aktiviert.

Solange Sie die Maustaste noch nicht losgelassen haben, können Sie eine
nommene Auswahl durch Drücken der Esc-Taste auch wieder abbrechen

Spurbearbeitungs- 
taste aktiviert

Markierter Audio

In- und Out-Pun
werden automat
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• Um weitere Spuren der Markierung hinzuzufügen oder aus dieser zu en
halten Sie die Umschalttaste gedrückt, während Sie auf die gewünschte
klicken.

In Anhang A finden Sie eine Zusammenfassung der Tastenkombinatione
Zusammenhang mit dem Bereichswerkzeug.

TIPP Um die Auswahl aller Spuren aufzuheben, ohne die In- und Out-Punkte 
dern, verwenden Sie den Befehl Deselect All im Menü Edit.

Editiertasten und In- und Out-Punkte
Sie können einen Bereich auch zum Editieren auswählen, indem Sie auf d
tiertaste der gewünschten Spur klicken, so dass diese stetig gelb leuchtet 
Setzen Sie anschließend die In- und Out-Punkte wie im Abschnitt 5.8, In

Out-Punkte setzen beschrieben. Der markierte Bereich wird hervorgeho
gestellt.

TIPP Um alle Spuren zum Editieren auszuwählen oder die Auswahl aufzuheb
klicken Sie auf die Schaltfläche „Alle editieren“ oberhalb der Editiertast

Spur 1 ( ).

Auswahlwerkzeug
Während Sie das Bereichswerkzeug in erster Linie zum Markieren von A
bereichen zwischen Eventgrenzen verwenden, markieren Sie mit dem Au

Zum Editieren  
ausgewählte Region

Zum Editieren 
ausgewählte Spur

Zum Editieren 
ausgewählte In- und Out-Punkte
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werkzeug ( ) einzelne oder mehrere vollständige Events, um sie zu edi
oder zu verschieben. 

• Um ein einzelnes Event auszuwählen, klicken Sie einmal darauf. 
• Um mehrere Events auszuwählen, oder um Events aus einer Auswahl z

nen, halten Sie die Umschalttaste gedrückt, und klicken Sie auf die gew
Events. Oder klicken Sie auf einen leeren Bereich und ziehen Sie die A
über die gewünschten Events auf. Um eine so vorgenommene Auswahl
chen (während Sie die Maustaste noch gedrückt halten), drücken Sie di
Taste.

  
1 Beginnen Sie 
mit dem Ziehen 

in einem leeren Bereich

  2 Maustaste losl
Markierter 

Audiobereich

1

2
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Wie bei der Auswahl mit dem Bereichswerkzeug werden auch hier autom
und Out-Punkte gesetzt und die Spureditiertasten aktiviert.

Hinweis Wenn Sie mehrere Events markiert haben, weist nur das zuletzt markier
Anfasser auf, obwohl sich der Bearbeitungsvorgang auf alle ausgewählte
auswirkt.

Weitere Informationen zum Auswahlwerkzeug finden Sie im Abschnitt 7
& Drop mithilfe des Auswahlwerkzeugs.

Bereichsauswahl erzwingen
Wenn Sie mit dem Auswahlwerkzeug einen Bereich auswählen wollen, d
weiteren Events umgeben ist (wie in der Abbildung unten), würden Sie b
such die Auswahl aufzuziehen möglicherweise unabsichtlich ein Event v
schieben.

Spurbearbeitungs- 
tasten aktiviert

Markierter Audiob

Auch leere Bereic
können markiert w

In- und Out-Punk
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Um dies zu vermeiden, halten Sie die Taste R gedrückt, während Sie mit 
wahlwerkzeug innerhalb des ersten Events ziehen. Sobald Sie die Mausta
lassen, erscheint der ausgewählte Bereich durch ein Rechteck hervorgeho

Hinweis Die Funktion Bereichsauswahl erzwingen ist nicht erforderlich, wenn Sie
Bereich mit dem Bereichswerkzeug markieren.

Mithilfe von „Auswahl 
erzwingen“ ausgewählte 
Events (weiß). 
Beachten Sie, dass die Events 
von anderen Events umgeben 
sind.

Option Tastaturbefehl Win Tastaturbefehl M

Bereichsauswahl erzwingen R + Klicken und Ziehen 
auf dem Event

R + Klicken und Zie
auf dem Event
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Drag & Drop mithilfe des Auswahlwerkzeugs
Neben dem Auswählen eines Bereichs (siehe Abschnitt 7.1, Einen Berei

Editieren auswählen) können Sie das Auswahlwerkzeug auch verwende
Events mittels Drag & Drop (Ziehen und Fallenlassen) zu verschieben. D
hinaus lassen sich damit Events und Überblendungen anpassen, Ankerpu
die Pegelautomation einfügen und bearbeiten sowie Locatormarken versc
(die Pegelautomation mithilfe von Ankerpunkten und das Anpassen von 
und Blenden sind in Kapitel 8, Erweiterte Editierfunktionen beschriebe

• Markieren Sie die Events wie im vorherigen Abschnitt beschrieben.
• Um mehrere markierte Events zu verschieben, ziehen das zuletzt marki

Event.

Mithilfe des Auswahlwerkzeugs sind auch komplexere Aufgaben zu bew

• Halten Sie die Alt-Taste (Macintosh: Wahltaste) gedrückt, während Sie
Event klicken und es an eine andere Position ziehen. Dadurch wird eine
des Events erzeugt, die Sie einfach einfügen, indem Sie die Maustaste l

• Wenn Sie während des Ziehens eines Audioevents die Strg-Taste (Maci
Befehlstaste) gedrückt halten, können Sie es nur nach oben oder unten 
Spur zur anderen verschieben, ohne seine Position auf der Zeitleiste zu
dern. Das ist vor allem dann hilfreich, wenn Sie Audiomaterial auf eine
Spur verschieben möchten, ohne die zeitliche Abfolge zu stören.

Um kurz auf ein anderes Werkzeug umzuschalten, stehen Ihnen mehrere 
kombinationen zur Verfügung:

Option Tastaturbefehl Win Tastaturbefehl M

bei aktivem Auswahl- oder 
Bereichswerkzeug kurz zur Lupe 
wechseln

F7 F7

bei aktivem Bereichswerkzeug kurz 
zum Auswahlwerkzeug wechseln

F6 F6
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Ausschneiden (Cut)
Durch das Ausschneiden wird das Audiomaterial zwischen den In- und O
Punkten entfernt und das nachfolgende Audiomaterial nach links verscho
Audiomaterial auszuschneiden, markieren Sie den gewünschten Bereich,
klicken Sie auf die Ausschneiden-Schaltfläche in der Edit-Leiste, oder w
im Menü Edit > Cut. Der ausgeschnittene Audiobereich wird in der Zwi
lage abgelegt.

Hinweis Wenn Sie einen leeren Bereich ausschneiden, wird dieser nicht in die Zw
blage kopiert.

Vorher:

Auszuschneidendes Audiomaterial ist markiert

Nachher:

Die nachfolgenden Events werden nach links verschoben

Option Tastaturbefehl Win Tastaturbefehl M

Ausschneiden Strg + X Befehlstaste + X
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Örtlich ausschneiden (Local Cut)
Durch örtliches Ausschneiden wird der markierte Bereich entfernt, und n
rechte Teil des bearbeiteten Events wie unten gezeigt nach links verschob

Vorher:

Nachher:

Auszuschneidendes  
Audiomaterial ist markiert

Benachbarte Events  
werden nicht verändert

Rechter Teil des Events  
wird nach links verschoben

Am Schnittpunkt wird 
automatisch ein Fade erzeugt

Option Tastaturbefehl Win Tastaturbefehl M

Örtlich ausschneiden Strg + � + S Befehlstaste + � + 
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Links ausschneiden (Left Cut)
Durch die Funktion „Links ausschneiden“ wird das gesamte Audiomateri
des ausgeschnitttenen Bereichs nach rechts verschoben.

Vorher:

Nachher:

Alle Events links des ausge- 
schnittenen Materials werden 
nach rechts verschoben

Auszuschneidendes  
Audiomaterial ist markiert

Option Tastaturbefehl Win Tastaturbefehl M

Links ausschneiden Strg + � + X Befehlstaste + � + 
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Örtlich links ausschneiden (Local Left Cut)
Die Funktion „Örtlich links ausschneiden“ entspricht der Funktion „Link
schneiden“, allerdings wird hierbei nur der links verbleibende Teil des bea
Events nach rechts verschoben.

Vorher:

Nachher:

Andere Events 
werden nicht verändert

Auszuschneidendes  
Audiomaterial ist markiert

Linker Teil des Events  
wird nach rechts verschoben

Option Tastaturbefehl Win Tastaturbefehl M

Örtlich links ausschneiden Strg + � + D Befehlstaste + � + 
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Kopieren (Copy)
Durch Kopieren werden ausgewählte Audiobereiche – definiert durch die
Out-Punkte sowie die Spureditiertasten – in die gewählte Zwischenablage
Den Inhalt der Zwischenablage können Sie dann in Audiospuren einfüge
Sie die Wahl haben, ob das vorhandene Material erhalten bleibt oder übers
wird. Um Audiomaterial zu kopieren, markieren Sie den gewünschten Be
und klicken Sie auf die Kopieren-Schaltfläche in der Edit-Leiste, oder wä
Menü Edit > Copy.

Hinweis MX-View verfügt über vier separate Zwischenablagen. Mehr zur Verw
der Mehrfachzwischenablage finden Sie in Abschnitt 7.26, Mehrfach
nablage verwenden.

Zu kopierender  
Bereich ist markiert

Beachten Sie, 
dass der leere Bereich 
ebenfalls kopiert wird

Option Tastaturbefehl Win Tastaturbefehl M

Kopieren Strg + C Befehlstaste + C
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Einfügen (Paste)
Um eine der Einfügebefehle verwenden zu können, müssen Sie bereits A
material in die Zwischenablage kopiert haben. Nachdem Sie einen In-Pun
haben, können Sie das Material einfügen. Der Inhalt der ausgewählten Zw
ablage wird am In-Punkt eingefügt und überschreibt eventuell vorhanden
material.

Vorher:

Nachher:

Audiobereich ist markiert  
und wird in die Zwischenablage kopiert

Audiomaterial wird rechts des  
In-Punkts eingefügt und überschreibt  
vorhandenes Audiomaterial

Neuer In-Punkt ist ausgewählt

Option Tastaturbefehl Win Tastaturbefehl M

Einfügen Strg + V Befehlstaste + V
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Links einfügen (Paste Left)
„Links einfügen“ entspricht dem normalen Einfügen, nur überschreibt hi
Inhalt der Zwischenablage das Audiomaterial links des In-Punkts.

Vorher:

Nachher:

Audiobereich ist markiert  
und wird in die Zwischenablage kopiert

Audiomaterial wird links des  
In-Punkts eingefügt und überschreibt  
vorhandenes Audiomaterial

In-Punkt ist ausgewählt

Option Tastaturbefehl Win Tastaturbefehl M

Links einfügen Strg + � + L Befehlstaste + � + 
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0 An Wiedergabeposition einfügen (Paste at Playhead)
Durch diese Funktion wird der In-Punkt an die Wiedergabeposition verse
der Inhalt der Zwischenablage dort eingefügt.

Markierter Audiobereich 
wurde in die 
Zwischenablage kopiert

Audiobereich wird rechts der 
Wiedergabeposition eingefügt 
 und überschreibt 
vorhandenes Audiomaterial

Wiedergabeposition

Vorher:

Nachher:

Option Tastaturbefehl Win Tastaturbefehl M

An Wiedergabeposition einfügen Strg + � + P Befehlstaste + � + 
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1 Löschen (Clear)
Die Funktion „Löschen“ entfernt das Audiomaterial zwischen den In- un
Punkten, ohne die Zeitposition anderer Audioevents zu beeinflussen. Der 
Bereich wird in die Zwischenablage gestellt.

Vorher:

Nachher:

Audiobereich ist markiert

Audiobereich ist gelöscht 
Andere Events 
werden nicht verändert

Option Tastaturbefehl Win Tastaturbefehl M

Löschen Strg + B Befehlstaste + B
AM MX-View Benutzerhandbuch v1.30DE  76



7

TASC

7.1
in und 
n Events 

ac
Editierfunktionen

2 Auftrennen (Open)
Die Funktion „Auftrennen“ fügt zwischen dem In- und Out-Punkt Stille e
verschiebt das dazwischen liegende Audiomaterial und alle nachfolgende
nach rechts.

Vorher:

Nachher:

Aufzutrennender 
Audiobereich ist markiert

Nach dem Auftrennen ist 
zwischen den In- und Out-Punkten 
ein leerer Bereich entstanden 
Das Audiomaterial wurde 
nach rechts verschoben

Option Tastaturbefehl Win Tastaturbefehl M

Auftrennen Strg + H Befehlstaste + H
AM MX-View Benutzerhandbuch v1.30DE  77



7

TASC

7.1
blage am 
choben.

ac
Editierfunktionen

3 Einfügen, nicht überschreibend (Insert)
Durch das nicht überschreibende Einfügen wird der Inhalt der Zwischena
In-Punkt eingefügt. Das vorhandene Audiomaterial wird nach rechts vers

Vorher:

Nachher:

Markierter Audiobereich wird  
in die Zwischenablage kopiert

Neuer In-Punkt 
ist gesetzt

Audiobereich wird am In-Punkt  
eingefügt und verschiebt  
vorhandenes Material nach rechts

Option Tastaturbefehl Win Tastaturbefehl M

Einfügen (nicht überschreibend) Strg + I Befehlstaste + I
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4 Auswahl wiederholt einfügen
Es gibt zwei Arten des wiederholten Einfügens: überschreibend (Paste) u
überschreibend (Insert). Zum wiederholten Einfügen (überschreibend ode
überschreibend) definieren Sie die In- und Out-Punkte und wählen dann 
Edit > Repeat Selection.

Beachten Sie, dass für das wiederholte Einfügen kein Kopieren erforderli
das wiederholte Material nicht in die Zwischenablage gestellt wird. Gebe
das Dialogfeld ein, wie oft das Audiomaterial wiederholt werden soll, un
Sie dann entweder Paste (überschreibend) oder Insert (nicht-überschrei
Durch wiederholtes überschreibendes Einfügen wird vorhandenes Audio
gelöscht.

Anzahl der Wiederholungen  
des Audiomaterials

Kontrollkästchen für  
nicht-überschreibendes Einfügen. 

Normalerweise nicht aktiviert 
(d.h. durch wiederholtes Einfügen wird 
vorhandenes Material überschrieben).
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Vorher:

 

Nachher:

Zu wiederholender Audiobereich  
(muss nicht in die Zwischenablage  
kopiert werden)

Überschreibendes Einfügen  
soll 20 mal wiederholt werden

Audiomaterial wurde 20 mal eingefügt 
Vorhandenes Audiomaterial wurde überschrieb
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Beim nicht-überschreibenden wiederholten Einfügen wird vorhandenes A
material nicht gelöscht, sondern nach rechts verschoben.

After:

Vorher:

 

Nachher:

Zu wiederholender Audiobereich  
(muss nicht in die Zwischenablage  
kopiert werden)

Nicht-überschreibendes Einfügen  
soll 5 mal wiederholt werden

Audiomaterial wurde 5 mal eingefügt 
Vorhandenes Audiomaterial wird  
nach hinten (nach rechts) verschoben

Option Tastaturbefehl Win Tastaturbefehl M

Wiederholen Strg + R Befehlstaste + R
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5 Teilen (Split)
Durch den Befehl Teilen wird ein Audioevent an der Wiedergabeposition g
dass daraus zwei Events entstehen.

TIPP Wenn Sie im Menü View > Splice Points die Darstellung von Trennpu
aktivieren, werden die einzelnen Events durch eine Linie deutlich vonein
abgehoben. Dies ist vor allem bei Editierfunktionen wie Teilen, Trennen 
auslösen nützlich.

Vorher:

Nachher:

Wiedergabeposition markiert  
die Stelle, an der geteilt wird

Es sind zwei Events entstanden,  
die durch eine Überblendung  
(Cross-Fade) getrennt sind

Option Tastaturbefehl Win Tastaturbefehl M

Teilen Strg + E Befehlstaste + E
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6 Trennen (Separate)
Die Funktion Trennen ähnelt der Funktion Teilen, allerdings wird ein Eve
diesem Fall sowohl am In-Punkt als auch am Out-Punkt getrennt, wodurc
Events entstehen.

Markierter Audiobereich

Das Audioevent wird an den  
In- und Out-Punkten getrennt

Vorher:

Nachher:

Option Tastaturbefehl Win Tastaturbefehl M

Trennen Strg + U Befehlstaste + U
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7 Herauslösen (Discard)
Durch das Herauslösen wird das Audiomaterial des betreffenden Audioev
beiden Seiten der In- und Out-Punkte entfernt. Andere Audioevents werd
beeinflusst.

Markierter Audiobereich

Das Audiomaterial links und rechts  
des Events wurde entfernt

Vorher:

Nachher:

Option Tastaturbefehl Win Tastaturbefehl M

Herauslösen Strg + T Befehlstaste + T
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8 Überschreibendes Einfügen mit zeitlichem Abstand (Sync Paste)
Der entscheidende Unterschied zum normalem Einfügen besteht bei dies
tion darin, dass Sie für das Einfügen mit zeitlichem Abstand keinen In-Pu
bestimmen müssen. Sie verschieben stattdessen die Wiedergabemarke, un
Audiomaterial in der Zwischenablage wird an dem Punkt eingefügt, der d
Abstand des In-Punktes zur Wiedergabemarke entsprach. 

Für das Einfügen mit zeitlichem Abstand müssen Sie zunächst Audiomat
die Zwischenablage kopieren und dabei auf die Position des In-Punktes i
auf die Wiedergabemarke achten. Bewegen Sie die Wiedergabemarke an
gewünschte Stelle, und führen Sie dann den Vorgang aus.

Beachten Sie den Abstand zwischen  
dem In-Punkt und der Wiedergabeposition

Markierter Audiobereich  
wird in die Zwischenablage gestellt

Vorher:

Nachher:
Der Abstand zwischen In-Punkt und  
Wiedergabeposition ist in der  
eingefügten Region derselbe

Durch das Einfügen wird  
vorhandenes Audiomaterial überschrieben

Wiedergabeposition wird  
an eine andere Stelle bewegt
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Hinweis Wenn Sie mit einem MMR-Recorder arbeiten, müssen Sie die Option Syn
Playhead aktivieren.

Option Tastaturbefehl Win Tastaturbefehl M

Einfügen mit zeitlichem Abstand Strg + � + V Befehlstaste + � + 
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9 Nicht-überschreibendes Einfügen mit zeitlichem Abstand (Sync In
Wie beim normalen Einfügen mit zeitlichem Abstand wird das Audiomate
bei dieser Einfügeart relativ zur Wiedergabeposition eingefügt. Allerding
hier das vorhandene Audiomaterial nicht durch die eingefügten Daten üb
schrieben. Das vorhandene Audiomaterial wird stattdessen nach hinten (n
rechts) verschoben.

Option Tastaturbefehl Win Tastaturbefehl M

Nicht-überschreibendes 
Einfügen mit zeitlichem Abstand

Strg + � + I Befehlstaste + � + 
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0 Schrittweises Verschieben (Nudge)
Beim schrittweisen Verschieben wird das Audiomaterial um den Wert ver
Sie in das zugehörige numerische Feld der Laufwerkssteuerung eingegeb

Durch wiederholtes Drücken der Plus- oder Minus-Taste können Sie das 
material um den entsprechenden Betrag weiter verschieben. Vorhandenes
material wird dabei überschrieben.

Wenn die In- und Out-Punkte innerhalb eines Audioevents liegen, wird d
durch das schrittweise Verschieben automatisch am In- und Out-Punkt ge

Markierter Audiobereich

Vorher:

Nach 
Nudge 
Right:

Nach 
Nudge 

Left:

Das markierte Event wurde  
um den Nudge-Wert nach rechts 
verschoben 
Beachten Sie, dass das Event  
an den In- und Out-Punkten  
automatisch getrennt wurde

Das markierte Event wurde  
um den Nudge-Wert nach links  
verschoben

Option Tastaturbefehl Win Tastaturbefehl M

Schrittweise nach rechts verschieben + (Plus-Zeichen) + (Plus-Zeichen)

Schrittweise nach links verschieben – (Minus-Zeichen) – (Minus-Zeichen)
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1 Direkt ausschneiden und einfügen (In to Now)
Durch diesen Befehl wird das Event zunächst an den In- und Out-Punkten
und anschließend an der Wiedergabeposition eingefügt.

Um ein Event auf diese Weise zu editieren, setzen Sie zuerst die In- und O
Punkte. Vergewissern Sie sich, dass in den gewünschten Spuren die Editi
gedrückt sind. Platzieren Sie die Wiedergabemarke an dem Punkt, an dem
kierte Audiomaterial eingefügt werden soll, und wählen Sie dann im Men
In to Now.

Markierter Audiobereich

Vorher:

Nachher:

Wiedergabeposition

Markierter Audiobereich  
wird gelöscht und an der  
Wiedergabeposition eingefügt

Option Tastaturbefehl Win Tastaturbefehl M

Direkt ausschneiden und einfügen Strg + M Befehlstaste + M
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2 Events umbenennen
Um einem Audioevent einen neuen Namen zuzuweisen, doppelklicken S
dem Auswahlwerkzeug auf das gewünschte Event. In dem nun erscheine
logfeld können Sie das Event umbenennen.

Hinweis Durch das Umbenennen eines Events wird nicht die Audiodatei umbena
auf der Festplatte gespeichert ist.

Option Tastaturbefehl Win Tastaturbefehl M

Umbenennen Doppelklick auf das Event Doppelklick auf das
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3 Rendern (Render)
Durch das Rendern wird aus mehreren Einzelevents ein zusammenhänge
Audioevent erzeugt. Auf diese Weise können Sie die Festplattenleistung 
sern. Wie bei der Konvertierung in den Bandmodus dienen die In- und Ou
beim Rendern als Anfangs- und Endzeiten. Sie können die Events einer e
Spur oder Events mehrerer Spuren rendern. Das dadurch neu erzeugte Ev
ersetzt die vorhandenen Audioevents.

Um Audiomaterial zu rendern, markieren Sie die gewünschten Events, un
Sie im Menü Edit > Render. Je nach Länge und Anzahl der ausgewählte
kann das Rendern einige Minuten dauern.

Hinweis Die Pegel- und Mute-Automation wird beim Rendern berücksichtigt. Die
gerenderte Audiodatei enthält sämtliche Änderungen des Lautstärkepeg

Markierter Audiobereich

Vorher:

Nachher:

Ein neues Audioevent ist entstanden
Beachten Sie, dass die Leerräume  
zwischen den Events  
ebenfalls gerendert wurden

Option Tastaturbefehl Win Tastaturbefehl M

Rendern Strg + � + R Befehlstaste + � + 
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4 Umkehren (Reverse)
Durch diese Funktion wird ein Audioevent oder ein Bereich umgekehrt, a
Audiomaterial rückwärts wiedergegeben wird. Nicht markierte Spuren bl
unverändert. Das umgekehrte Audioevent ersetzt das vorhandene Audiom
Um Audiomaterial umzukehren, markieren Sie die gewünschten Events b
gewünschten Bereich und wählen im Menü Edit > Reverse. Je nach Lä
Anzahl der ausgewählten Spuren kann das Umkehren einige Minuten dau

Markiertes Audioevent

Vorher:

Nachher:

Durch den Reverse-Befehl  
wird die Wellenform umgekehrt
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5 Rückgängig machen und Wiederherstellen (Undo, Redo)
Der MX-2424 ist in der Lage, die letzten 99 Bearbeitungsvorgänge oder 
nahmen rückgängig zu machen. Dabei gilt:

• Es lassen sich nur Arbeitsschritte innerhalb des aktuellen Projekts rückg
machen – Sie können die Funktion also nicht auf ein zuvor geladenes P
anwenden.

• Die einzelnen Arbeitsschritte werden nicht zusammen mit dem Projekt 
chert – die Liste wird jedes Mal gelöscht, wenn Sie ein neues Projekt b
ein Laufwerk deaktivieren oder den Recorder ausschalten.

Mit dem Befehl Wiederherstellen lässt sich der zuletzt rückgängig gemac
Arbeitsschritt wiederherstellen. Die Befehle Rückgängig (Undo) und 
Wiederherstellen (Redo) rufen Sie über die Edit-Leiste, das Menü Edit o
hilfe von Tastenkombinationen auf.

Hinweis Auf dem MMR stehen Ihnen nur 10 Undo-Ebenen zur Verfügung.

Option Tastaturbefehl Win Tastaturbefehl M

Rückgängig machen Strg + Z Befehlstaste + Z

Wiederherstellen Strg + Y Befehlstaste + Y

ängig    Wiederherstellen
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6 Mehrfachzwischenablage verwenden
In MX-View können Sie über die Edit-Leiste auf bis zu vier voneinander
gige Zwischenablagen zugreifen.

Material in die Zwischenablage stellen
Klicken Sie auf die Nummer der Zwischenablage, in der Sie das Audiom
ablegen möchten. Markieren Sie einen Bereich oder ein Event, und wähle
eine Editierfunktion wie Ausschneiden, Kopieren oder Löschen, durch di
gewählte Bereich in die Zwischenablage kopiert wird. Sie können nun ein
Zwischenablage aktivieren und eine weitere Editierfunktion ausführen.

Inhalt der Zwischenablage einfügen
Wählen Sie die gewünschte Zwischenablage aus. Führen Sie anschließen
beliebigen Einfügebefehl aus, um den Inhalt der Zwischenablage in das M
Hauptfenster einzufügen. Sie können nun eine andere Zwischenablage ak
und deren Inhalt einfügen.

Der Inhalt der Zwischenablagen bleibt auch erhalten, wenn Sie ein andere
laden. Er wird allerdings gelöscht, wenn Sie das MX-2424 ausschalten od
Laufwerk deaktivieren (unmount) bzw. bereinigen.

Hinweis Wenn Sie keine Zwischenablage auswählen, wird das Material in Zwisch
1 abgelegt.
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In diesem Kapitel befassen wir uns mit erweiterten Editierfunktionen und
Ihnen, wie Sie die Event-Längen oder Pegel anpassen sowie Ein-, Aus- u
blendungen erzeugen und anpassen.

Grundsätzliches zum Anpassen von Events
Um ein Event anzupassen, markieren Sie es mit dem Auswahlwerkzeug (
dass es hervorgehoben wird und nun sieben Anfasser aufweist:

Hinweis Wenn Sie ein Event mit dem Bereichswerkzeug markieren, werden die E
zwischen den In- und Out-Punkten blau hervorgehoben. Mit dem Bereic
zeug können Sie keine Events anpassen.

Horizontale Anfasser

Fade-Anfasser

Lautstärke-Anfasser

In- und Out-Marken
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Die Event-Länge anpassen
Diese Funktion ermöglicht Ihnen, die Länge eines Events anzupassen, oh
zeitliche Position zu verändern. Um ein Audioevent anzupassen, klicken 
einmal auf das Event. Die Anfasser werden angezeigt. Bewegen Sie den 
zeiger auf die horizontalen Anfasser, worauf er die Form eines Doppelpfe
annimmt. Ziehen Sie den Anfasser nach links oder rechts, und lassen Sie
staste los, sobald die gewünschte Länge erreicht ist.

Hinweis Es ist nicht möglich, ein Event über das Ende der Audiodatei hinaus zu ve
Wenn Sie ein Event nach links oder rechts verlängern wollen, und das Au
werkzeug „hängt“, dann haben Sie den Rand Ihrer Audiodatei erreicht.

Der linke horizontale Anfasser  
wird nach links gezogen

Vorher:

Nachher:

Nach dem Loslassen des Anfassers  
wird das Event nach links verlängert  
Der Out-Punkt wird nicht verändert
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Mehrere Events anpassen
Um mehrere Events anzupassen, wählen Sie die gewünschten Events mit
Auswahlwerkzeug ( ) aus, wie im Abschnitt 7.1, „Einen Bereich zum E
auswählen“ unter Auswahlwerkzeug beschrieben. Sie können mit dem A
werkzeug auch eine Bereichsauswahl aufziehen, um mehrere Events zu m
Beachten Sie, dass nur das zuletzt ausgewählte Event Anfasser aufweist, 
ausgewählten Events hervorgehoben werden. Passen Sie das Event an, au
zuletzt geklickt haben. Die Veränderung wirkt sich auf alle markierten Ev

Vorher:

Nachher:

 

Dieses Event wurde  
zuerst ausgewählt

Das zuletzt ausgewählte Event  
wird nach rechts verlängert

Auch das zuerst ausgewählte Event 
wird nach rechts verlängert

Das zuletzt ausgewählte Event  
weist Anfasser auf
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Alle anderen Events verschieben (Ripple Trim)
Mithilfe dieser Methode können Sie das gesamte Audiomaterial der ausg
Spur nach rechts oder links verschieben. Um Audiomaterial zu verschiebe
Sie die Alt-Taste gedrückt, während Sie am Anfasser ziehen.

Vorher:

Nachher:

 
Nachfolgende Events  
werden nach rechts verschoben

Markiertes Event

Der Abstand zwischen den Events  
bleibt erhalten

Bei gedrückter Alt-Taste  
wird das Event nach rechts verschoben

Option Tastaturbefehl Win Tastaturbefehl M

Alle anderen Events verschieben Alt + Ziehen des Anfassers Alt + Ziehen des An
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Zum nächsten Event verschieben (Trim To Next)
Mit dieser Funktion verschieben Sie das Audiomaterial innerhalb der aus
wählten Spur genau bis zum nächsten Event. Wählen Sie dazu das gewün
Event aus, halten Sie die Umschalttaste gedrückt, und ziehen Sie den Anf
wenig in die gewünschte Richtung. Lassen Sie die Maustaste los, und der 
ausgewählten Events springt zum nächsten Event, so dass sich die Rände
Events berühren.

Vorher:

Nachher:

 

Das ausgewählte Event  
springt zum nächsten Event

Bei gedrückter Umschalttaste  
wird das ausgewählte Event  
etwas nach rechts gezogen

Option Tastaturbefehl Win Tastaturbefehl M

Zum nächsten Event verschieben � + Ziehen des Anfassers � + Ziehen des An
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Schnittpunkt von zwei Events verschieben
Wenn Sie zwei aneinandergrenzende Events auswählen, erscheint zwisch
beiden Events ein roter Anfasser (siehe folgende Abbildung). Mithilfe di
Anfassers können Sie den Schnittpunkt der Events verschieben, ohne die
Out-Punkte zu verändern. Markieren Sie dazu zunächst zwei Events mit 
samem Rand. Bewegen Sie den roten Anfasser am Schnittpunkt der Even
lassen Sie die Maustaste an der gewünschten Position los.

Nachher:

Vorher:

 

Neue Position des 
gemeinsamen Anfassers

Die In- und Out-Punkte  
behalten ihre Position bei

Die beiden aneinandergrenzenden Events  
haben einen gemeinsamen roten Anfasser,  
der nach rechts gezogen wird
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Anpassen der Eventpegel
Es gibt zwei Möglichkeiten, in MX-View die Audiopegel zu ändern: 

• Bei der Pegelautomation erstellen und bewegen Sie Ankerpunkte, um d
stärke einer Spur zu ändern. Sie ist die flexiblere der beiden Methoden 
(Abschnitt 9.3, Pegelautomation mithilfe von Ankerpunkten).

• Durch das direkte Anpassen der Eventpegel wie hier beschrieben, könne
Pegel eines Events oder einer Gruppe von Events schnell anpassen. Bei
Methoden lassen sich auch kombinieren.

Sie können die drei Anfasser unabhängig voneinander verschieben, um d
eines Events zu ändern. Die Wellenform spiegelt den geänderten Pegel w

TIPP Wenn Sie beim Bewegen des Anfassers die Strg-Taste gedrückt halten, kö
eine Feinabstimmung vornehmen.

      
Linker Pegel-Anfasser des Events  
wurde nach unten bewegt

Mittlerer Pegel-Anfasser des Events  
wurde nach unten bewegt

Ausgewähltes Event

Rechter Pegel-Anfasser des Events  
wurde nach unten bewegt
AM MX-View Benutzerhandbuch v1.30DE  101



8

TASC

8.8

reichs-
unkt 
 Länge 

 Sie die 
Erweiterte Editierfunktionen

Ein-, Aus- und Überblendungen (Fades und Crossfades)

Fades erzeugen
Um eine Einblendung (Fade-in) zu erzeugen, bestimmen Sie mit dem Be
werkzeug einen In-Punkt auf der linken Seite des Events und einen Out-P
innerhalb des Events. Dieser Bereich wird hervorgehoben dargestellt. Die
der Markierung bestimmt die Länge des Fades. 

Klicken Sie auf die Fade-Schaltfläche in der Edit-Leiste oder verwenden
Tastenkombination, um das Fade zu erzeugen.

Vorher

Nachher:

Markierter Audiobereich

Fade-in wurde erzeugt
Die Wellenform  
spiegelt das Fade-in wider
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Eine Ausblendung (Fade-out) erzeugen Sie auf dieselbe Weise, nur muss
hierbei der In-Punkt innerhalb des Events befinden, während der Out-Pun
des Events liegt.

Crossfades erzeugen
Um eine Überblendung (Crossfade) zu erzeugen, bestimmen Sie mit dem
Bereichswerkzeug einen In-Punkt innerhalb des linken Events und einen 
Punkt innerhalb des rechten Events. Der Bereich wird hervorgehoben dar
Klicken Sie auf die Fade-Schaltfläche oder drücken Sie Strg + F, um das C
zu erzeugen.

Option Tastaturbefehl Win Tastaturbefehl M

Fade Strg + F Befehlstaste + F

Vorher:

Nachher:

Bereich zwischen zwei Events  
ist für ein Crossfade markiert

Crossfade beginnt am In-Punkt  
und endet am Out-Punkt
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Sie können ein Crossfade auch erzeugen, indem Sie ein Event mit einem F
ein Event mit einem Fade-out hineinschieben. Nehmen Sie das Event ein
dem Auswahlwerkzeug ( ) auf, und schieben Sie es in das nächste Eve

Fades anpassen
Sie können Fades mithilfe der Fade-Anfasser anpassen. Wählen Sie das 
gewünschte Event mit dem Auswahlwerkzeug aus, damit die Anfasser an
werden. Setzen Sie den Mauszeiger auf den gewünschten Fade-Anfasser.

Vorher:

Nachher:

Event wird mithilfe des  
Anpasswerkzeugs ausgewählt  
und nach rechts bewegt

Das Fade-out des linken Events und  
das Fade-in des rechten Events  
überlagern sich und erzeugen ein Crossfade
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verwandelt sich in das Auswahlwerkzeug. Bewegen Sie den Anfasser mi
Mauszeiger.

Hinweis Wenn Sie ein Fade über das Ende eines anderen Events hinaus verlänger
das nicht markierte Event gelöscht. Im unten stehenden Beispiel wird das
linken Events über die Events in der Mitte hinaus verlängert. Dadurch we
Events in der Mitte entfernt.

Vorher:

Nachher:

Markiertes Event
Der untere rechte Fade-Anfasser  
wird nach rechts gezogen

Fade-out wurde verlängert

Die Events in der M
werden gelöscht

Fade wird über die
in der Mitte hinaus

Fade wurde verlän

Vorher:

Nachher:
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Audiomaterial im Event verschieben (Event Slip)
Mit dieser Funktion können Sie das Audiomaterial nach links oder rechts
schieben, ohne die In- und Out-Punkte zu bewegen. Wählen Sie dazu ein E
dem Auswahlwerkzeug ( ) aus, halten Sie die Taste A gedrückt, und zi
das Event an die gewünschte Position.

Durch das Verschieben bleiben die In- und Out-Punkte erhalten. Das Aud
material links des In-Punkts bzw. rechts des Out-Punkts wird „mitgezoge
Audiomaterial außerhalb der In- und Out-Punkte bleibt unverändert.

Vorher:

Nachher:

Markiertes Event wird bei  
gedrückt gehaltener A-Tast
nach rechts gezogen

Event wurde innerhalb der
In- und Out-Punkte versch

In- und Out-Punkte  
bleiben unverändert
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0 Zusammenfügen (Compile)
Durch das Zusammenfügen erzeugen Sie eine virtuelle Spur, die ausgewä
Audioevents anderer virtueller Spuren enthält. 

Halten Sie die Umschalttaste gedrückt, und wählen Sie die einzelnen Eve
dem Auswahlwerkzeug aus. Beachten Sie, dass Sie nur Events aus einer 
von virtuellen Spuren auswählen können.

Wählen Sie im Menü Edit > Compile. Geben Sie der zu erstellenden Sp
Namen. Es wird eine neue virtuelle Spur mit den zusammengefügten Eve
erzeugt.

Hinweis Falls sich Events überlappen, so haben die Events der weiter oben liegen
Priorität.

Markierte Events sollen 
zusammengefügt werden

Zusammengefügte Spur
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In diesem Kapitel befassen wir uns eingehend mit Gruppen, Locatormark
der Pegel- und Muteautomation.

Locatormarken verwenden
Im Locatormarken-Fenster werden die Nummern und Namen aller Locato
des geladenen Projekts angezeigt – wenn mehrere Recorder aktiv sind, fü
Maschine getrennt. Klicken Sie auf das Dreieck vor dem Recordernamen
Liste der Marken für einen Recorder anzuzeigen.

Das Locatormarken-Fenster ist mit dem Hauptfenster eines Projekts verb
Um es anzuzeigen, laden Sie ein Projekt, öffnen Sie das Hauptfenster für
sprechenden Recorder und klicken Sie in der Edit-Leiste auf das Marken

Sie können das Markenfenster wie üblich auch über das Menü oder Tastat
aufrufen, beachten Sie jedoch, dass ein Hauptfenster oder ein Gruppenfen
Vordergrund sein muss, damit Sie auf das Markenfenster zugreifen könne
Schließen des Hauptfensters wird auch das dazugehörige Markenfenster 
geschlossen.

Wenn Sie auf eine Marke doppelklicken, springt die Wiedergabemarke zu
chenden Locatorposition.

Sobald eine Marke ausgewählt ist (durch einfaches Klicken im Locatorm
Fenster), werden die Optionen im Menü Markers aktiviert und können z
Umbenennen oder Löschen von Marken verwendet werden. Um mehrere
auszuwählen, können Sie wie üblich die Umschalt- oder die Strg- (Win) b
hungsweise Befehlstaste (Mac) zu Hilfe nehmen. Ausgewählte Marken k
auch durch Drücken der Entf-oder Rückschritt-Taste gelöscht werden.

Option Tastaturbefehl Win Tastaturbefehl M

Locatormarken-Fenster öffnen Strg + 5 Befehlstaste + 5
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Mit Benutzergruppen arbeiten
Benutzergruppen geben Ihnen die Möglichkeit, mehrere Spuren gemeins
bedienen und zu editieren. Wenn Sie beispielsweise einen Chor aus viele
stimmen aufnehmen wollen, können Sie die zugehörigen Spuren in einer 
gruppe zusammenfassen, um sie gemeinsam scharfzuschalten, zu schneid
ohne sie jedesmal einzeln auswählen zu müssen.

Beim Erstellen eines neuen Projekts gibt es noch keine Benutzergruppen,
folge gehören auch die Spuren noch keiner Benutzergruppe an. Um mit G
arbeiten zu können, müssen Sie solche zunächst erstellen und dann die Sp
diesen Gruppen hinzufügen. Benutzergruppen sind optional, wenn Sie sie
benötigen, können Sie die hier beschriebenen Funktionen außer Acht lass

Das Gruppenfenster
Das Gruppenfenster ist mit dem Hauptfenster eines Projekts verbunden. U
anzuzeigen, laden Sie ein Projekt, öffnen Sie das Hauptfenster für den en
chenden Recorder und klicken Sie in der Edit-Leiste auf das Gruppensym
können das Gruppenfenster wie üblich auch über das Menü oder Tastatur
aufrufen, beachten Sie jedoch, dass ein Hauptfenster oder ein Markenfen
Vordergrund sein muss, damit Sie auf das Gruppenfenster zugreifen könn

Im Gruppenfenster werden alle Gruppen des geladenen Projekts einschlie
ihrer Farben, Namen und Nummern angezeigt – wenn mehrere Recorder 
sind, für jede Maschine getrennt. Klicken Sie auf das Dreieck vor dem R
namen, um die Liste der Gruppen für einen Recorder anzuzeigen. Beim S
des Hauptfensters wird auch das dazugehörige Gruppenfenster geschloss

Um eine Gruppe auszuwählen, klicken Sie darauf. Um mehrere Gruppen
wählen, können Sie wie üblich die Umschalt- oder die Strg- (Win) bezieh
weise Befehlstaste (Mac) zu Hilfe nehmen.

Wenn das Gruppenfenster im Vordergrund ist, können Sie im Menü Grou
Gruppen erstellen, Gruppen umbenennen und Gruppen löschen.
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Wellenformen in der Farbe der Gruppe
Zur leichteren Unterscheidung nehmen die Wellenformen einer Spur die F
Benutzergruppe an, der die Spur angehört. Die Wellenformen von Spuren
keiner Gruppe angehören, sind schwarz.

Eine neue Benutzergruppe erstellen (im Gruppenfenster)

1 Rufen Sie das Gruppenfenster auf, indem Sie auf das entsprechen
Symbol in der Edit-Leiste klicken.

Wenn noch keine 12 Gruppen vorhanden sind, ist nun der Menübefehl zum Ers
neuen Gruppe verfügbar.

Wenn mehrere Recorder aktiv sind, müssen Sie im Gruppenfenster zunächst de
wählen, für den Sie eine neue Gruppe erstellen wollen. Bequemerweise können
mehrere Recorder auswählen und so eine neue Gruppe für mehrere Recorder g
erstellen. Dies ist jedoch nur möglich, wenn für jeden der gewählten Recorder 
12 Gruppen bereits vorhanden sind.

2 Wählen Sie im Menü Groups > New Group. 

Eine neue Gruppe wird erstellt. Die neue Gruppe wird automatisch fortlaufend
riert. Wenn beispielsweise die Gruppen 1, 2, 4 und 5 bereits vorhanden sind, wi
Gruppe mit der Bezeichnung „Group 3“ dem Projekt hinzugefügt. Wenn Sie di
Gruppe für mehrere Recorder gleichzeitig erstellen, wird für jeden Recorder di
verfügbare Gruppennummer vergeben (z. B. „Group 2“ für Recorder 1 und „G
Recorder 2). 

Eine neue Benutzergruppe erstellen (im Hauptfenster)
Sie können eine neue Benutzergruppe auch direkt im Hauptfenster erstell
eine oder mehrere Spuren der Gruppe automatisch hinzufügen. Dabei kön
einen Namen für die Gruppe vergeben und die Farbe der Gruppe auswäh

1 Öffnen Sie das Hauptfenster.
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2 Klicken Sie in einer Spur auf eine leere Gruppentaste (die Spur d
noch keiner Gruppe angehören). 

Um mehrere Spuren der neuen Gruppe hinzuzufügen, klicken Sie bei gedrückt
Umschalttaste auf leere Gruppentasten. Dabei muss es sich nicht um aufeinand
Spuren handeln.

3 Wählen Sie im Menü Edit > New User Group….

4 Geben Sie einen Namen ein und wählen Sie eine Farbe für die Gr

5 Klicken Sie auf OK, um die Gruppe zu erstellen.

Die Gruppentasten der gewählten Spuren nehmen nun die Nummer und Farbe 
an. Zudem erscheint die neue Gruppe im Gruppenfenster.

Eine Gruppe umbenennen 

1 Rufen Sie das Gruppenfenster auf, indem Sie auf das entsprechen
Symbol in der Edit-Leiste klicken.

2 Wählen Sie die Gruppe aus, die Sie umbenennen wollen. 

Sie können nur eine Gruppe zur gleichen Zeit umbenennen. 

3 Wählen Sie im Menü Groups > Rename Group.

Es erscheint ein Dialogfeld.

4 Geben Sie einen neuen Namen ein. 

Gruppennamen dürfen bis zu 100 Zeichen lang sein.

Gruppen löschen
Rufen Sie das Gruppenfenster auf, indem Sie auf das entsprechende Symb
Edit-Leiste klicken.

1 Wählen Sie die Gruppe(n) aus, die Sie löschen wollen. 
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2 Wählen Sie im Menü Groups > Delete Group oder drücken Sie 
oder die Rückschritt-Taste. 

Die gewählten Gruppen werden gelöscht.

Spuren einer Benutzergruppe hinzufügen
Sobald Sie eine Benutzergruppe erstellt haben, können Sie weitere Spure
Gruppe hinzufügen, indem Sie im Kontextmenü der jeweiligen Spur die 
auswählen. Sobald Sie eine Spur einer Gruppe hinzugefügt haben, nehme
Gruppentaste und die Wellenform die Farbe der Gruppe an.

Benutzergruppen in der Praxis
Um alle Spuren einer Gruppe zu aktivieren oder zu deaktivieren, klicken
Hauptfenster auf die Gruppentaste einer beliebigen Spur der Gruppe. Fal
Spuren, die einer Gruppe angehören, virtuelle Spuren sichtbar sind, werd
ebenfalls zusammen mit der Gruppe aktiviert oder deaktiviert. Mehrere G
von Spuren wählen Sie aus, indem Sie bei gedrückt gehaltener Umschalt
die Gruppentasten klicken.

Auf gleiche Weise lassen sich Gruppen auch im Gruppenfenster auswähle
Doppelklicken aktivieren Sie die Spuren, die der entsprechenden Gruppe
hören. Sobald eine oder mehrere Gruppen aktiv sind, können Sie auf jede 
Eingangs-, Aufnahmebereitschafts- oder Editiertaste einer Spur in einer d
aktiven Gruppen klicken, um die Funktion für alle Spuren der aktiven Gr
ein- oder auszuschalten. Um alle Gruppen zu deaktivieren, doppelklicken
Gruppenfenster auf None (keine).

Um eine Funktion für eine einzelne Spur in der aktiven Gruppe ein- oder
schalten, halten Sie beim Klicken die Strg-Taste (Win) beziehungsweise 
Befehlstaste (Mac) gedrückt.

Hinweis Wenn Sie auf mehreren Recordern eine Gruppe mit dem gleichen Namen
den, wird diese wie eine einzige Gruppe behandelt. Beim Aktivieren der

ruppentaste
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auf einem Recorder wird also die gleiche Gruppe auch auf dem anderen 
aktiviert.

Bereiche auswählen
Wenn Gruppen aktiviert sind und Sie ziehen mit dem Bereichswerkzeug 
kreuz) über die Audioevents, wählen Sie damit nur Bereiche in den Spure
den aktiven Gruppen angehören.

Pegelautomation mithilfe von Ankerpunkten
Bei der Pegelautomation erstellen und bewegen Sie Ankerpunkte, um die
stärke einer Spur zu ändern. Jede einzelne Spur verfügt über eigene Auto
daten für die Lautstärke ähnlich den automatisierten Fadern eines Mischp

Ankerpunkte für die Automation erstellen
Klicken Sie zuerst auf die Schaltfläche für die Pegelautomation ( ) in d
Leiste, und aktivieren Sie das Auswahlwerkzeug ( ). Um einen Ankerp
erstellen, klicken Sie in die gewünschte Spur und bewegen den Punkt auf
gewünschten Pegel. In einem kleinen Feld wird die Verstärkung (sowie in
mern die relative Änderung der Verstärkung) angezeigt, was Ihnen dabei 
gewünschten Wert zu finden.

Um einen vorhandenen Ankerpunkt anzupassen, klicken Sie darauf. Der 
wird weiß hervorgehoben, und Sie können ihn innerhalb der Spur in jede 
verschieben. Wenn Sie eine Feinabstimmung an einem vorhandenen Ank
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vornehmen möchten, halten Sie während des Ziehens die Strg-Taste (Mac
Befehlstaste) gedrückt.

Ankerpunkte bearbeiten
Während Sie Ankerpunkte bearbeiten, ist keine Bearbeitung des Audiom
möglich. Wenn das Bereichswerkzeug aktiv ist, können Sie die Automati
in der gewohnten Weise editieren (kopieren, einfügen, löschen usw.).

Wählen Sie die zu editierenden Automationsdaten mit dem Bereichswerk
Der Bereich wird hervorgehoben, und die Ankerpunkte nehmen eine wei
an. Sie können die Punkte nun wie gewohnt durch schrittweises Verschie

zu bearbeitender Punkt 
ist markiert

Automationsdaten  
(absoluter Pegel sowie  
relative Pegeländerung  
des markierten Punkts)
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Kopieren, Einfügen usw. bearbeiten. Um Ankerpunkte zu löschen, marki
die gewünschten Punkte, und drücken Sie die Rückschritttaste (←). 

TIPP Wenn das Bereichswerkzeug aktiv ist, können Sie Automationsdaten kop
und an einem späteren Punkt Ihres Stücks oder in einer anderen Spur ein
ist also ganz einfach, Strophe und Refrain eines Songs mit derselben Peg
mation zu versehen.

Vorher:

Nachher:

Markierter Bereich  
wird in die Zwischenablage kopiert

Die Automationsdaten  
werden am In-Punkt eingefügt

Option Tastaturbefehl Win Tastaturbefehl M

weitere Ankerpunkte auswählen � + Klicken � + Klicken

Ankerpunkte kopieren Alt + Ziehen Alt + Ziehen

im rechten Winkel verschieben � + Ziehen � + Ziehen
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Mute-Automation
Die Mute-Automation ermöglicht Ihnen, wie bei einem automatisierten M
jede Spur einzeln stumm zu schalten. Klicken Sie zuerst auf die Schaltflä
die Mute-Automation ( ) in der Edit-Leiste, und aktivieren Sie das Aus
werkzeug ( ). Ein Mute-Automationspunkt kann sich entweder am obe
(Stummschaltung aus) oder am unteren Rand (Stummschaltung ein) eine
befinden.

Um einen Mute-Automationspunkt zu erstellen, klicken Sie in die gewün
Spur, und bewegen Sie den Punkt entweder an den oberen oder an den un
Rand der Spur. Sie können einen Mute-Automationspunkt auch auf der Z
nach rechts oder links verschieben.

Ansonsten gelten für das Bearbeiten von Mute-Automationspunkten dies
Regeln wie für die Pegelautomation (Abschnitt 9.3).

TIPP Mithilfe der folgenden Tastaturbefehle können Sie schnell zwischen den
tungsmodi für Wellenformen, Pegel- und Mute-Automation umschalten

Spur ist nicht stummgeschaltet

Spur ist stummgeschaltet

F8: Audioevents bearbeiten
F9: Pegelautomation bearbeiten
F10: Mute-Automation bearbeiten
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In diesem Kapitel befassen wir uns mit der Verwaltung von Projekten un
werken sowie dem Sichern und Wiederherstellen von Projekten über das N
mithilfe der Smart Copy-Funktion. Daneben finden Sie Funktionen zur F
tenpflege wie Disk Cleanup, Laufwerksinitialisierung, Low-Level-Forma
usw.

1 Ein Projekt laden
Das Project/Track-Fenster listet alle Laufwerke, Projekte und Spuren alle
netzten MX-2424 oder MMR/MMP auf. Die Listenpfeile dienen dazu, E
anzuzeigen oder zu verbergen. Um ein Projekt zu laden, rufen Sie das Pro
Track-Fenster auf und klicken auf den Listenpfeil des gewünschten Gerät
alle angeschlossenen Laufwerke angezeigt werden. Klicken Sie nun auf d
Listenpfeil des gewünschten Laufwerks (bzw. dessen SCSI-ID), um alle a
diesem Laufwerk enthaltenen Projekte anzuzeigen. Um ein Projekt zu lad
pelklicken Sie auf den Namen oder das Symbol des gewünschten Projekt
einfaches Klicken auf den Listenpfeil des Projekts können Sie alle darin 
tenen Spuren anzeigen.

Listenanzeige der 
verfügbaren Geräte

Listenanzeige der 
verfügbaren Festplatten

Listenanzeige der 
verfügbaren Projekte

Spuren im Projekt
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2 Projekte verwalten
Bevor Sie eine Funktion wie Smart Copy, Umbenennen oder Konvertieru
Bandmodus anwenden können, müssen Sie im Project/Track-Fenster ein 
markieren. Am unteren Rand des Project/Track-Fensters finden Sie eine 
fläche zum Abbrechen des Vorgangs sowie eine Fortschrittsanzeige.

Smart Copy
Wählen Sie für die Smart Copy-Funktion zunächst das gewünschte Proje
und klicken Sie dann im Project/Track-Fenster auf File > Smart Copy. 

In dem nun erscheinenden Dialogfenster können Sie das Projekt umbene
die SCSI-ID des Ziellaufwerks angeben.

TIPP Sie können ein Projekt auch per Smart Copy kopieren, indem Sie es im P
Track-Fenster auswählen und dann auf ein anderes Laufwerk ziehen.

Option Tastaturbefehl Win Tastaturbefehl M

Smart Copy Strg + C Befehlstaste + C
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Während des Smart Copy-Vorgangs erscheint am unteren Rand des Proje
Fensters eine prozentuale Fortschrittsanzeige. Sobald der Vorgang beend
wird dies durch einn entsprechenden Hinweis und ein Häkchen angezeig
Sie nun auf das Häkchen klicken, wird der Hinweis geschlossen.

Klicken Sie auf das Häkchen,  
um den Hinweis zu schließen
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Konvertierung in den Bandmodus
Um ein Projekt in den Bandmodus zu konvertieren, wählen Sie zunächst 
gewünschte Projekt aus, und klicken Sie dann im Project/Track-Fenster a
Tape Mode Convert. In dem nun erscheinenden Dialogfenster werden
gefordert, die SCSI-ID des Ziellaufwerks anzugeben.

Wie bei der Smart Copy-Funktion erscheinen am unteren Rand des Fenst
prozentuale Fortschrittsanzeige und eine Schaltfläche zum Abbrechen.

Hinweis Weitere Informationen zur Konvertierung in den Bandmodus finden Sie
führungslehrgang für den MX-2424.

Schaltfläche zum  
Abbrechen des Vorgang

Bezeichnung des 
laufenden Vorgangs

Prozentuale Fortschritts
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Projekt umbenennen
Um ein Projekt umzubenennen, wählen Sie es zuerst aus und klicken dan
ject/Track-Fenster auf File > Rename Project. In dem nun erscheinend
logfenster können Sie das Projekt umbenennen. Geben Sie den gewünsch
Namen ein, und klicken Sie auf Rename, um die Änderung zu bestätige
auf Cancel, um abzubrechen.

Projekt/Spur löschen
Um ein Projekt zu löschen, wählen Sie es zuerst aus und klicken dann im
Track-Fenster auf File > Delete Project. Klicken Sie auf Delete, um e
löschen, oder auf Cancel, um abzubrechen.

Option Tastaturbefehl Win Tastaturbefehl M

Projekt umbenennen Strg + R Befehlstaste + R
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3 Sichern/Wiederherstellen über das Netzwerk
Die folgenden Funktionen bieten Ihnen die Möglichkeit, Projekte über da
werk zu sichern und wiederherzustellen.

Sichern über das Netzwerk (Network Backup)
Mit MX-View können Sie Ihr Projekt sichern, indem Sie es via Ethernet 
Hostcomputer übertragen. Die Sicherungen werden im BU-Format (Time
BackUp) gespeichert. Dieses Format erlaubt die Segmentierung der Sich
datei je nach Kapazität des verwendeten Sicherungsmediums. Sobald die
mente sich auf Ihrem Hostcomputer befinden, lassen sie sich leicht auf C
CD-RWs DVD-Rs oder anderen Sicherungsmedien archivieren. Auf dies
können Sie beispielsweise ein 4 GB großes Projekt von der Festplatte Ihr
ders mithilfe Ihres Computers auf ein paar CD-Rs sichern. 

Bevor Sie mit der Netzwerksicherung beginnen, wählen Sie im im Projec
Fenster im Menü File > Net Backup Format das gewünschte Format a

Wenn Sie die Option Manual wählen, können Sie die Größe jedes Segm
selbst bestimmen.
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Wählen Sie anschließend im Menü File > Network Backup. Sie werde
fordert, einen Speicherort sowie einen neuen Namen für die Sicherung ein

Wenn Sie nun auf Save klicken, wird der Vorgang gestartet und am unte
des Project/Track-Fensters erscheint eine Fortschrittsanzeige.

Wiederherstellen über das Netzwerk (Network Restore)
Um ein Projekt von Ihrem Hostcomputer wiederherzustellen, klicken Sie
Project/Track-Fenster auf Menü File > Network Restore. Wählen Sie 
Sicherungsdatei eines Sicherungssatzes aus. Wenn Sie beispielsweise ein
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wiederherstellen, das aus den drei Segmenten MXProjekt.bu1, MXProjek

MXProjekt.bu3 besteht, so wählen Sie die Datei MXProjekt.bu3 aus.

Klicken Sie nun auf Open. Sie werden aufgefordert, einen Projektnamen
geben und das SCSI-Ziellaufwerk auszuwählen, auf dem das Projekt wie
stellt werden soll.

Wenn Sie nun auf OK klicken, wird der Vorgang gestartet und am unteren
des Project/Track-Fensters erscheint eine Fortschrittsanzeige. Ein Dialogf
miert Sie, ob die Rücksicherung erfolgreich abgeschlossen wurde.
AM MX-View Benutzerhandbuch v1.30DE  124



10

TASC

10.
 Sie erst 
tplatten-
Sie im 

e akti-

chlossen 
ite 23 des 

aufwerke 
s > 
eräte-ID 
Projekte und Laufwerke verwalten

4 Festplattenverwaltung
Bevor Sie eine der Funktionen zur Festplattenverwaltung nutzen, müssen
alle Laufwerke (Volumes) deaktivieren. Dies gilt jedoch nicht für die Fes
säuberung, das Disk Cleanup. Zum Deaktivieren und Aktivieren wählen 
Project/Track-Fenster Volumes > Unmount bzw. Mount.

Festplattensäuberung (Disk Cleanup)
Vergewissern Sie sich vor einer Festplattensäuberung, dass alle Laufwerk
viert sind, und wählen Sie dann Project/Track-Fenster Volumes > Disk 
Cleanup. Ein Dialogfeld erscheint, sobald der Vorgang erfolgreich abges
wurde. Weitere Informationen zur Festplattensäuberung finden Sie auf Se
MX-2424-Einführungslehrgangs.

Initialisieren (Initialize)
Vergewissern Sie sich vor dem Initialisieren eines Laufwerks, dass alle L
deaktiviert sind, und wählen Sie dann im Project/Track-Fenster Volume
Initialize. In dem nun erscheinenden Dialogfeld wählen Sie die SCSI-G
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und das Dateiformat. Sobald die Initialisierung erfolgreich abgeschlossen
erscheint eine entsprechende Meldung.

Weitere Informationen zur Festplatteninitialisierung finden Sie auf Seite 
MX-2424-Einführungslehrgangs.

Hinweis Wenn die SCSI-ID nicht im Geräte-Dropdown-Menü aufgeführt ist, wähle
„Other“, und geben Sie die SCSI-ID anschließend in das Eingabefeld ein.

Low-Level-Formatierung
Vergewissern Sie sich vor einer Low-Level-Formatierung, dass alle Lauf
deaktiviert sind, und wählen Sie dann im Project/Track-Fenster Volume
Level Format. In dem nun erscheinenden Dialogfeld wählen Sie die SC
Geräte-ID. Klicken Sie auf Format, um den Vorgang zu starten. Sobald 
matierung erfolgreich abgeschlossen wurde, erscheint ein entsprechendes
dungsfeld. Weitere Informationen zur Low-Level-Formatierung finden S
Seite 24 des MX-2424-Einführungslehrgangs.

Sicherungsmedium löschen
Vergewissern Sie sich vor dem Löschen eines Sicherungsmediums, dass 
werke deaktiviert sind, und wählen Sie dann im Project/Track-Fenster Vo
Backup Erase. In dem nun erscheinenden Dialogfeld wählen Sie die SC
Geräte-ID. Beachten Sie, dass das Löschen eines Sicherungsmediums nu
DVD-RAMs oder Travan-Medien möglich ist. Sobald der Vorgang erfolg
abgeschlossen ist, erscheint eine entsprechende Meldung.

Dropdown-Menü  
für SCSI-Geräte-ID

Dropdown-Menü  
für Dateiformat
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5 Update des Betriebssystems (MX-2424)
Neue Versionen des Betriebssystems für den MX-2424 werden auf der Ta
US-Website zum Download bereitgestellt (www.tascam.com). Dabei han
sich um selbst extrahierende Dateien (für Mac oder PC) zusammen mit ei

mentation im PDF-Format. 

So aktualisieren Sie das Betriebssystem im MX-2424:

1 Laden Sie die neuste Version des Betriebssystems von der Tascam 
und speichern Sie sie in einem geeigneten Ordner Ihres Rechners

Die Datei ist ein selbst extrahierendes Archiv. Doppelklicken Sie darauf, um d
systemdatei und die Dokumentationsdateien in diesen Ordner zu entpacken.

2 Legen Sie die TL-Speicherkarte in den MX-2424 ein.

Die Karte wird benötigt, um das neue Betriebssystem zu installieren. Alle Date
Karte werden gelöscht.

3 Wählen Sie im Network-Fenster Machines > Update Software.
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Sie werden nun aufgefordert, das DXIMAGE (das Abbild des Betriebssystems)
len, das auf die TL-Media-Karte (die SmartMedia-Card) geschrieben werden s

4 Markieren Sie die Betriebssystemdatei, und klicken Sie auf Open
der Aktualisierung zu beginnen. 

Die neue Version des Betriebssystems wird auf die TL-Speicherkarte übertrage
Anschließend werden Sie aufgefordert, den MX-2424 aus- und wieder einzusc

5 Lassen Sie die TL-Speicherkarte stecken, während Sie den MX-2
und wieder einschalten. 

Das neue Betriebssystem auf der TL-Speicherkarte wird dabei automatisch in das Flash-R
MX-2424 übertragen.

6 Sobald die Übertragung abgeschlossen ist, entfernen Sie die TL-S
karte. 

7 Schalten Sie den MX-2424 erneut aus und wieder ein, um das Up
abzuschließen.

Falls die Fernbedienung RC-2424 angeschlossen ist, wird deren Software ebenfalls autom
aktualisiert.
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Spuren

In diesem Kapitel erfahren Sie alles, was Sie über den Umgang mit Spure
müssen. Wir zeigen Ihnen, wie Sie Spuren laden, entladen, löschen oder 
nennen und mit virtuellen Spuren arbeiten. Die Definitionen der Begriffe
dene Spuren“, „entladene Spuren“ und „virtuelle Spuren“ finden Sie in A
5.5, Mit Spuren arbeiten sowie ab Seite 17 des MX-2424-Einführungsle
(Virtuelle Spuren).

1 Das Spurmenü
Wenn Sie eine Spur-Funktion benötigen, klicken Sie auf die Schaltfläche
Spurmenü. Dieses Menü steht Ihnen für jede virtuelle oder geladene Spu
fügung.

Folgende Funktionen sind wählbar: neue virtuelle Spur erstellen (New V
Track), Spur laden (Load Track), Spur entladen (Unload Track), Spur umb
(Rename Track) und Spur löschen (Delete Track).

Schaltfläche für das Spurmenü

Spurmenü
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2 Eine neue virtuelle Spur erstellen
Wählen Sie im Spurmenü den Eintrag New Virtual Track. In dem dara
erscheinenden Dialogfeld können Sie der neuen virtuellen Spur einen Na
geben. Der vorgegebene Name besteht aus dem Spurnamen und der Take
Nummer.

Klicken Sie auf OK, um die neue virtuelle Spur zu erzeugen. Sie erschein
der Originalspur.

Virtuelle Spuren aktivieren
Um zwischen einer aktiven und einer inaktiven virtuellen Spur umzuscha
klicken Sie einfach auf die zugehörige Aktivierungsschaltfläche, die dara
vorgehoben wird. Wahlweise können Sie alle virtuellen Spuren verbergen
Sie auf die Schaltfläche zum Anzeigen/Verbergen der virtuellen Spuren k

Schaltfläche der virtuellen Spur  
ist nicht gedrückt: Aufnahme und 
Wiedergabe sind auf dieser Spur 

nicht möglich. Sie lässt sich 
jedoch weiterhin editieren.

Schaltfläche der 
virtuellen Spur ist gedrückt:  

Auf dieser Spur sind Aufnahme 
und Wiedergabe möglich.

Schaltfläche zum  
Anzeigen/Verbergen  
der virtuellen Spuren

Anfasser
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Virtuelle Spuren verschieben
Inaktive virtuelle Spuren können Sie mithilfe der Spur-Anfasser nach obe
unten verschieben. Eine weiße Hilfslinie hilft Ihnen bei der Platzierung.

Spuren laden
Um eine Spur zu laden, klicken Sie im Spurmenü auf Load Track. Das P
Track-Fenster wird geöffnet, in dem Sie eine Spur aus dem aktiven Proje
aus anderen Projekten auswählen können. Sobald Sie die gewünschte Spu
bestimmt haben, wählen Sie mithilfe des Listenfelds Destination Track
der Spur aus.

Hinweis Beachten Sie, dass bei Projekten mit hoher Samplingfrequenz (88,2–96 k
12 Spuren zur Verfügung stehen. Als Zielspur sind dann nur die Spuren 1
wählbar.

Weiße Hilfslinie hilft  
beim Verschieben einer Spur

Aktive virtuelle Spur

Inaktive virtuelle Spuren

Listenfeld zur Auswahl  
der Zielspur
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3 Spuren entladen
Um eine Spur zu entladen, klicken Sie im Spurmenü auf Unload Track.
erscheint ein Dialogfeld, in dem Sie den Vorgang abbrechen oder bestätig
können.

4 Spuren umbenennen
Um eine Spur umzubenennen, klicken Sie im Spurmenü auf Rename Tr
dem nun erscheinenden Dialogfenster können Sie die Spur umbenennen.
Sie den gewünschten Namen der Spur ein, und klicken Sie auf OK, um fo
fahren, oder auf Cancel, um abzubrechen.

5 Spuren löschen
Um eine Spur zu löschen, klicken Sie im Spurmenü auf Delete Track. K
Sie auf Delete, um fortzufahren, oder auf Cancel, um abzubrechen.
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Mehrere Recorder im Netzwerk

Über das MX-View-Hauptfenster können Sie auf mehrere Recorder gleic
zugreifen. Dieses Kapitel beschreibt, wie Sie bei Verwendung mehrerer R
vorgehen.

1 Verbindung mit mehreren Recordern herstellen
MX-View erkennt automatisch alle im lokalen Netzwerk vorhandenen Re
und listet sie im Network-Fenster auf. Eventuell wollen Sie aber in bestim
Situationen eine Verbindung mit einem Recorder herstellen, der sich nich
lokalen Netzwerk befindet. Angenommen, ein MX-View-Benutzer in ein
Studio in Hamburg möchte eine Verbindung zu einem MX-2424 in einem
Studio herstellen. Mit der Funktion „New Remote Machine“ ist dies mög

Verbindung zu entfernten Recordern herstellen
Um dem Network-Fenster einen entfernten Recorder (Remote-Recorder)
fügen, rufen Sie das Network-Fenster auf, und wählen Sie im Menü Mac
New Remote Machine. Geben Sie den Namen und die IP-Adresse des
Recorders ein.

Der Recorder erscheint nun in der Geräteliste des Network-Fensters. Ein 
gelsymbol kennzeichnet ihn als Remote-Recorder.

Recorder in das MX-View-Hauptfenster laden
Wählen Sie im Network-Fenster bei gedrückter Umschalttaste die gewün
Recorder (lokal oder Remote) aus, die daraufhin hervorgehoben werden. 
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klicken Sie in den hervorgehobenen Bereich, als ob Sie die Verbindung z
einzelnen Recorder herstellen. Die Recorder erscheinen nun übereinande
View-Hauptfenster. Jeder Recorder ist durch eine eigene Zeitleiste abgeg
kann unabhängig von den anderen Recordern im Netzwerk betrieben wer
Reihenfolge der Recorder im MX-View-Hauptfenster hängt von der sorti
Spalte ab. Standardmäßig wird nach dem Namen des Recorders sortiert. S
können die Einträge im Network-Fenster nach jeder Spalte sortieren, inde
die Spaltenüberschrift klicken.

Wenn das MX-View-Hauptfenster mehrere Recorder auflistet, erscheint r
neben den Tasten für die Laufwerkssteuerung eine zusätzliche Liste mit d
Geräte-IDs (Bus-IDs). Das Transport-Fenster und die Tastatur sprechen je
den Recorder an, dessen ID hervorgehoben ist. Um mit den Laufwerkstas

Spuren 
Recorder 1

Spuren 
Recorder 2

Z
R

Z
R

Spuren Recorder 1
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der Tastatur einen anderen Recorder anzusteuern, klicken Sie einmal auf 
gewünschte ID-Nummer.

Bei Verwendung mehrerer Recorder erscheint auch in der Machine Info-L
Feld, das den aktuell angesprochenen Recorder anzeigt.

Geräte-ID (Bus-ID).  
In diesem Fall spricht die Laufwerkssteuerung  
den Recorder mit der Bus-ID 2 an.

Dieser Recorder 
wird momentan 

gesteuert
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2 Netzwerk an die Studioumgebung anpassen
Das Network-Fenster bietet Ihnen ein System, mit dem Sie auch in einer 
umgebung mit mehreren Räumen und Recordern den Überblick behalten
werden die Recorder in den Studios so organisiert, dass beispielsweise ei
Benutzer in Studio A nicht auf den Recorder eines anderen Benutzers in 
zugreifen kann.

Ein neues Studio konfigurieren
Wählen Sie im Menü des Network-Fensters Machine > New Studio. 

Geben Sie den Namen des neuen Studios ein. Jedes Studio wird als Ordn
zeigt. Um einem Studio Recorder hinzuzufügen, ziehen Sie das Recorder
in den gewünschten Studio-Ordner. Im folgenden Beispiel enthält das Ne
Fenster drei Studios: Studio A, Studio B und Studio C. Studio B verfügt ü
24-Spur-Remote-Recorder.

Über das Menü Machines im Network-Fenster können Sie Recorder vo
Studio zum anderen verschieben, sie umbenennen oder löschen. Über die
können Sie auch Studios umbenennen und löschen.
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3 Mit mehreren Recordern arbeiten
Um alle Recorder gleichzeitig über das MX-View-Hauptfenster zu betrei
müssen Sie sie über den TL-Bus synchronisieren (bei MMR/MMPs über
MMR-Bus). Vergewissern Sie sich, dass alle Recorder online sind und da
Bus-Master das Gerät ist, das momentan von der Laufwerkssteuerung an
chen wird (Informationen, wie Sie das Gerät ändern, das aktuell über die
werkstasten und die Tastatur angesprochen wird, finden Sie in Abschnitt 
Verbindung mit mehreren Recordern herstellen). Jeder Recorder verf
eine Online-Schaltfläche auf der linken Seite seiner Zeitleiste, mit der Sie
feststellen können, welche Geräte jeweils online sind.

Links der Online-Schaltfläche befindet sich ein Geräte-Dropdown-Menü
angezeigt wird, sobald mehrere Recorder im MX-View-Hauptfenster vor
sind. Über dieses Menü können Sie auf die Recorder-Einstellungen zugre
Fenster mit den Pegelanzeigen öffnen, mit einem neuen Projekt beginnen
Project/Track-Fenster aufrufen.

Das Editieren des Audiomaterials im MX-View-Hauptfenster funktionier
mehreren Recordern genauso, als ob Sie mit nur einem Gerät arbeiten. Es
dings nicht möglich, Audiomaterial von einem Recorder auf die Audiospu
anderen Recorders zu verschieben.

Online-SchaltflächeGeräte- 
Dropdown-Menü

rzbefehle
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hang A: MX-View und MX-2424 über ein Netzwerk verbind

Damit MX-View mit dem MX-2424 kommunizieren kann, müssen Sie ei
Netzwerk einrichten, das Ihren Rechner mit dem oder den MX-2424 verb
Der MX-2424 verwendet das Netzwerkprotokoll TCP/IP, das auch im Int
wendet wird und heute auf den meisten Rechnern vorinstalliert ist. 

Hinweis Die Einrichtung von Netzwerken ist ein äußerst umfassendes und nicht g
einfaches Thema. Haben Sie deshalb bitte Verständnis, wenn wir in diese
buch nur die grundlegenden Einstellungen für ein einfaches Netzwerk, b
aus einem Rechner und einem oder mehreren MX-2424 erläutern könne

Im Folgenden gehen wir davon aus, dass auf Ihrem Rechner bereits eine N
karte (Fast Ethernet, 100 Mbps) und das TCP/IP-Protokoll installiert sind
beschreiben, welche Einstellungen Sie auf dem oder den MX-2424 und a
Windows- oder Macintosh-Rechner vornehmen müssen, um den Datenau
zwischen den Recordern und MX-View zu ermöglichen.

Wenn Ihr Rechner, auf dem MX-View installiert ist, noch nicht Teil eines
werks ist, können Sie die hier beschriebenen Einstellungen verwenden. S
Rechner bereits Teil eines funktionierenden Netzwerks sein, müssen Sie 
möglicherweise andere Einstellungen vornehmen. Fragen Sie in diesem F
Netzwerk-Administrator, welche IP-Adressen und welche Teilnetzmaske
Ihren MX-2424-Recordern einstellen müssen, um sie in das vorhandene N
einzubinden.
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zwerkeinstellungen für die MX-2424-Recorder vornehmen
Sie müssen für jeden Recorder, den Sie ins Netzwerk einbinden wollen, e
Adresse und eine Teilnetzmaske festlegen.

IP-Adresse festlegen
Die IP-Adresse dient der eindeutigen Identifizierung eines Netzwerkgerä
darf daher nicht an zwei Geräte im Netzwerk zugleich vergeben werden. 
hier beschriebenen Netzwerk verwenden wir den privaten Adressraum vo
192.168.000.001 bis 192.168.000.255.

1 Drücken Sie am MX-2424 die SETUP-Taste, und wählen Sie Menü

Die aktuell eingestellte IP-Adresse wird angezeigt:

2 Drücken Sie TRIM, verwenden Sie den Shuttle-Ring und die Pfei
um 192.168.000.002 als IP-Adresse für den ersten Recorder festzu
und drücken Sie STORE/YES, um die Eingabe zu bestätigen.

Wir empfehlen Ihnen, die IP-Adressen fortlaufend zu vergeben: 192.168.000.0
Rechner, auf dem MX-View installiert ist (siehe Abschnitte , Netzwerk unter 
98 einrichten und , Netzwerk unter Mac OS einrichten), 192.168.000.002 fü
ten Recorder, 192.168.000.003 für den zweiten Recorder usw.

Teilnetzmaske festlegen
In dem hier beschriebenen Netzwerk verwenden wir die Teilnetzmaske 
255.255.255.000. Sie besagt, dass die IP-Adressen dieses Netzes sich nur

950 IP Address

*000.000.000.000

950 IP Address

*192.168.000.002
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vierten Zahl unterscheiden (also 192.168.000.001 bis 192.168.000.255). 
netzmaske muss für alle Geräte in diesem Netzwerk gleich sein.

1 Drücken Sie die SETUP-Taste, und wählen Sie Menü 951.

Die aktuell eingestellte Teilnetzmaske wird angezeigt:

2 Drücken Sie TRIM, verwenden Sie den Shuttle-Ring und die Pfei
um 255.255.255.000 als Teilnetzmaske einzustellen, und drücken S
STORE/YES, um die Eingabe zu bestätigen.

Stellen Sie die Teilnetzmaske für alle weiteren Recorder auf den gleichen Wert

IP-Adresse eines Gateways einstellen
In größeren Netzwerken kann es erforderlich sein, den Recordern die IP-
eines Gateways mitzuteilen. Der Vollständigkeit halber sei hier erwähnt, 
die IP-Adresse des Gateways im Menü 952 einstellen können. In dem hie
beschriebenen Netzwerk behalten Sie jedoch die Einstellung 000.000.000

Hinweis Damit Änderungen an den Netzwerkeinstellungen wirksam werden, mü
die MX-2424-Recorder neu starten.

951 IP Net Mask

*000.000.000.000

951 IP Net Mask

*255.255.255.000

952 IP Gateway

*000.000.000.000
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zwerk unter Windows 98 einrichten

1 Klicken Sie auf dem Desktop mit der 
rechten Maustaste auf Netzwerkumgebung, 
und wählen Sie Eigenschaften.

2 Markieren Sie auf der Registerkarte Konfiguration 
das TCP/IP-Protokoll, das mit Ihrer Netzwerkkarte 
verbunden ist, und klicken Sie auf Eigenschaften.
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3 Aktivieren Sie auf der Registerkarte IP-Adresse 
das Optionsfeld IP-Adresse festlegen und geben Sie 
die IP-Adresse und Teilnetzmaske (Subnet Mask) ein, 
wie in der Abbildung gezeigt.

4 Klicken Sie auf OK, bis alle Fenster geschlossen sind, 
und starten Sie den Rechner neu, sobald Sie dazu 
aufgefordert werden.
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zwerk unter Mac OS einrichten

1 Wählen Sie im Apfel-Menü Kontrollfelder >> TCP/IP.

2 Nehmen Sie die Einstellungen vor wie in der Abbildung gezeigt.

3 Schließen Sie das Fenster, um die Einstellungen zu übernehmen.
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hang B: Laufwerks- und Dateisymbole

Symbol Beschreibung
Macintosh-Laufwerk

Windows-Laufwerk

WaveFrame-Laufwerk (nur MMR/MMP)

Backup-Laufwerk

Unbekanntes Laufwerk

Ordner

OMF (nur MMR/MMP)

TimeLine SDII (nur MMR/MMP)

Akai (nur MMR/MMP)

SSF (nur MMR/MMP)

Deva (nur MMR/MMP)

Pro Tools (nur MMR/MMP)

Sonic Solution (nur MMR/MMP)

Fairlight (nur MMR/MMP)

Open TL
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Fenster (anzeigen/verbergen)

Projekte verwalten

Optionen für Spurtasten

Option Windows Macintosh

Laufwerkssteuerung Strg + 1 Befehlstaste + 1

Übersicht Strg + 3 Befehlstaste + 3

Pegelanzeigen Strg + 4 Befehlstaste + 4

Locatormarken Strg + 5 Befehlstaste + 5

Gruppen Strg + 6 Befehlstaste + 6

Projekt/Spur Strg + 7 Befehlstaste + 7

Netzwerk Strg + 8 oder
Strg + � + N

Befehlstaste + 8 oder
Befehlstaste + � + N

Option Windows Macintosh

Neues Projekt anlegen Strg + N Befehlstaste + N

Projekt öffnen Strg + O Befehlstaste + O

Fenster schließen Strg + W Befehlstaste + W

MX-View beenden Strg + Q Befehlstaste + Q

Option Windows Macintosh

Taste umschalten und Tasten der 
anderen Spuren auf gleichen Zustand 
setzen 

Alt + Klicken Wahltaste + Klicken

Taste umschalten und Tasten aller 
anderen Spuren auf entgegengesetzten 
Zustand setzen

Strg + Klicken Befehlstaste + Klicken
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In den Audiospuren navigieren
Option Windows Macintosh

Wiedergabe und Stopp Leertaste Leertaste

„In to Out“-Wiedergabe � + Leertaste � + Leertaste

Aufnahme Strg + Leertaste Befehlstaste + Leerta

Schneller Vorlauf Strg + . (Punkt) Befehlstaste + . (Punk

Schneller Rücklauf Strg + , (Komma) Befehlstaste + , (Kom

Schrittweise vorwärts . (Punkt) . (Punkt)

Schrittweise zurück , (Komma) , (Komma)

Zur nächsten Locatormarke Strg + � Befehlstaste + �

Zur vorherigen Locatormarke Strg + � Befehlstaste + �

Zur Locatormarke nn V, dann zwei Ziffern für 
Locatormarke

V, dann zwei Ziffern fü
Locatormarke

Zum nächsten Edit Tab Tab

Zum vorherigen Edit � + Tab � + Tab

Zum In-Punkt I I

Zum Out-Punkt O O

Wiedergabeposition an beliebige Stelle 
setzen

 + Klicken  + Klicken

In-Punkt an der Wiedergabeposition 
setzen

Strg + � oder
C, dann I

Befehlstaste + � ode
C, dann I

Out-Punkt an der Wiedergabeposition 
setzen

Strg + � oder
C, dann O

Befehlstaste + � ode
C, dann O

Locatormarke nn setzen C, dann zwei Ziffern für 
Locatormarke

C, dann zwei Ziffern f
Locatormarke

Nächste Locatormarke setzen
(Nummerierung erfolgt automatisch)

Eingabetaste Eingabetaste

Online Strg + J Befehlstaste + J
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Mit Events und Ankerpunkten arbeiten
Option Windows Macintosh

Auswahlwerkzeug ( ) F2 F2

Event/Ankerpunkt auswählen  + Klicken  + Klicken

Events/Ankerpunkte zur Auswahl 
hinzufügen oder aus der Auswahl 
entfernen

 + � + Klicken oder
� + � / �

 + � + Klicken ode
� + � / �

Alle Events in Spur auswählen Strg + A Befehlstaste + A

Event/Ankerpunkt verschieben  + Ziehen  + Ziehen

Verschieben im 90°-Winkel  + Strg + Ziehen  + Befehlstaste + Z

Event duplizieren und verschieben  + Alt + Ziehen  + Wahltaste + Zie

Mehrere ausgewählte Events/
Ankerpunkte verschieben

 + � + Ziehen  + � + Ziehen

Audiomaterial innerhalb des 
ausgewählten Events verschieben

A +  + Ziehen A +  + Ziehen

Bereichsauswahl erzwingen R +  + Ziehen R +  + Ziehen

Alle anderen Events verschieben (beim 
Anpassen)

Alt + Ziehen des Anfassers Wahltaste + Ziehen d
Anfassers

Zum nächsten Event verschieben (beim 
Anpassen)

� + Ziehen des Anfassers � + Ziehen des Anfas

Event umbenennen  + Doppelklick  + Doppelklick

Vorgang abbrechen (bei gedrückter 
Maustaste)

Esc Esc

Vorübergehend zu  wechseln  + F7  + F7
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Mit Audiobereichen arbeiten
Option Windows Macintosh

Bereichswerkzeug ( ) F1 F1

Bereich auswählen  + Ziehen  + Ziehen

Auswahl erweitern  + � + Ziehen  + � + Ziehen

Spur zur Auswahl hinzufügen oder aus 
der Auswahl entfernen

 + � + Klicken  + � + Klicken

Auswahl verkleinern  + Strg + Ziehen  + Befehlstaste + Z

Vorgang abbrechen (bei gedrückter 
Maustaste)

Esc Esc

Vorübergehend zu  wechseln  + F6  + F6

Vorübergehend zu  wechseln  + F7  + F7
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Audiomaterial editieren
Option Windows Macintosh

Rückgängig machen Strg + Z Befehlstaste + Z

Wiederherstellen Strg + Y Befehlstaste + Y

Löschen Strg + B, Entf-Taste,
Rückschritt-Taste

Befehlstaste + B, Entf
Rückschritt-Taste

Kopieren Strg + C Befehlstaste + C

Ausschneiden Strg + X Befehlstaste + X

Örtlich ausschneiden Strg + � + S Befehlstaste + � + S

Links ausschneiden Strg + � + X Befehlstaste + � + X

Örtlich links ausschneiden Strg + � + D Befehlstaste + � + D

Einfügen Strg + V Befehlstaste + V

Einfügen mit zeitlichem Abstand Strg + � + V Befehlstaste + � + V

Einfügen (nicht überschreibend) Strg + I Befehlstaste + I

Einfügen (nicht überschreibend)
mit zeitlichem Abstand

Strg + � + I Befehlstaste + � + I

Links einfügen Strg + � + L Befehlstaste + � + L

An Wiedergabeposition einfügen Strg + � + P Befehlstaste + � + P

Direkt ausschneiden und einfügen Strg + M Befehlstaste + M

Duplizieren Strg + D Befehlstaste + D

Wiederholen Strg + R Befehlstaste + R

Auftrennen Strg + H Befehlstaste + H

Teilen Strg + E Befehlstaste + E

Trennen Strg + U Befehlstaste + U

Herauslösen Strg + T Befehlstaste + T

Schrittweise nach rechts verschieben + (Plus-Zeichen) + (Plus-Zeichen)

Schrittweise nach links verschieben – (Minus-Zeichen) – (Minus-Zeichen)

Fade Strg + F Befehlstaste + F

Fade bis Anfang Alt + D Wahltaste + D

Fade bis Ende Alt + G Wahltaste + G

Rendern Strg + � + R Befehlstaste + � + R
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Anzeige ändern
Option Windows Macintosh

F3 F3

Bereich vergrößern  + Ziehen  + Ziehen

Bildlauf nach oben/unten Bild-auf/Bild-ab Bild-auf/Bild-ab

Erste Spur anzeigen Pos1 Pos1

Letzte Spur anzeigen Ende Ende

Gesamtes Projekt anzeigen Strg + � + Z oder 

Doppelklick auf 

Befehlstaste + � + Z 

Doppelklick auf 

Samples anzeigen Z Z

Spurhöhe vergrößern Strg + + (Plus-Zeichen) Befehlstaste + + 

Spurhöhe verkleinern Strg + – (Minus-Zeichen) Befehlstaste + –

Ansicht auf In-Punkt zentrieren � + I � + I

Ansicht auf Out-Punkt zentrieren � + O � + O

Ansicht auf Wiedergabeposition 
zentrieren

Strg + P Befehlstaste + P

bei aktiver Lupe kurz zum 
Bereichswerkzeug wechseln

F6 F6

bei aktiver Lupe kurz zum 
Auswahlwerkzeug wechseln

F7 F7
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Wiedergabeoptionen nutzen

Werte in numerische Felder eingeben

Option Windows Macintosh

Auto-Aufnahme/Rehearse-Modus Strg + � + A Befehlstaste + � + A

Wiedergabe mit Pre-/Post-Roll Strg + K Befehlstaste + K

Wiedergabe wiederholen L L

Loop-Wiedergabe Strg + L Befehlstaste + L

Wiedergabe bis In-Punkt T, dann I T, dann I

Wiedergabe bis Out-Punkt T, dann O T, dann O

Wiedergabe ab In-Punkt F, dann I F, dann I

Wiedergabe ab Out-Punkt F, dann O F, dann O

Wiedergabe über In-Punkt Y, dann I Y, dann I

Wiedergabe über Out-Punkt Y, dann O Y, dann O

Option Windows Macintosh

Zum nächsten Feld springen # #

Zwischen Stunden, Minuten, Sekunden, 
Frames und Subframes  wechseln

� / � � / �

Wert erhöhen/verringern � / � � / �

Eingabe bestätigen Eingabetaste Eingabetaste
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